
 

 

SiteManager for Management Personnel 

Student Guide 

Release 3.6a 

May 2007 

 



 

 

SiteManager for Management Personnel 

Student Guide 

Release 3.6a 

May 2007 

 



Prepared by 

 
 

Address: 5700 SW 34th Street, Suite 1235, Gainesville, Florida 32608-5371 
Phone: (352) 381-4400 • Fax: (352) 381-4444 • E-mail: info@infotechfl.com • Web: www.infotechfl.com 

 

AASHTO Trns•port, the AASHTO Trns•port logo, AASHTOWare, the AASHTOWare logo, BAMS/DSS, the Trns•port BAMS/DSS logo, CAS, the Trns•port CAS logo, 
CES, the Trns•port CES logo, Trns•port Estimator, the Trns•port Estimator logo, Trns•port Expedite, the Trns•port Expedite logo, LAS, the Trns•port LAS logo, PES, the 
Trns•port PES logo, Trns•port SiteManager, the Trns•port SiteManager logo, Trns•port SitePad, the Trns•port SitePad logo, Trns•port SiteXchange, and the Trns•port 
SiteXchange logo are registered trademarks of the American Association of State Highway and Transportation Officials (AASHTO). Trns•port is a commonly used name for 
AASHTO Trns•port. 

Trns•port BAMS/DSS, Trns•port CAS, Trns•port CES, Trns•port FieldBook, the Trns•port FieldBook logo, Trns•port FieldBuilder, the Trns•port FieldBuilder logo, 
Trns•port FieldManager, the Trns•port FieldManager logo, Trns•port FieldPad, the Trns•port FieldPad logo, the Trns•port Intranet logo, Trns•port LAS, Trns•port PES, 
Trns•port SiteNet, and Trns•port TrnsNet are trademarks of AASHTO. 

AASHTO Trns•port, Trns•port BAMS/DSS, Trns•port CAS, Trns•port CES, Trns•port Expedite, Trns•port LAS, Trns•port PES, Trns•port SiteManager, Trns•port SiteNet, 
Trns•port SitePad, Trns•port SiteXchange, and Trns•port TrnsNet represent one or more proprietary products of AASHTO. 

Appia, the Appia logo, Appia Estimator, the Appia Estimator logo, Appia Expedite, the Appia Expedite logo, Appia FieldManager, the Appia FieldManager logo, Estimator 
and FieldNet are trademarks of Info Tech, Inc., and represent proprietary products of Info Tech, Inc. 

FieldManager is a registered trademark of Info Tech, Inc. and represent products of Info Tech, Inc. and the State of Michigan (through Michigan Department of 
Transportation). 

FieldBook, FieldBuilder and FieldPad are trademarks of Info Tech, Inc. and represent products of Info Tech, Inc. and the State of Michigan (through Michigan Department 
of Transportation). 

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. 

ANSI and the ANSI logo are registered trademarks of the American National Standards Institute. 

ARM and ARM Powered are registered trademarks of ARM Limited. 

Authorware, Blue Sky Software, Blue Sky, Coldfusion, Contents Tab Composer, Director, Dreamweaver, Fireworks, Flash, FlashHelp, Help to Source, HomeSite, HTML 
Help Studio, Macromedia, Macromedia Flash, RoboHelp Office, RoboHelp, WebHelp, and WinHelp and/or other trademarks referenced herein are either registered 
trademarks or trademarks of Macromedia, Inc. and eHelp, Inc. in the U.S. and/or other countries. Macromedia does not sponsor, affiliate, or endorse AASHTO or Info Tech, 
Inc. products and/or services. 

Borland and the Borland Logo are trademarks or registered trademarks of Borland Software Corporation in the United States and other countries. 

Capability Maturity Model, CMM, CMM Integration, CMMI, and Standard CMMI Appraisal Method for Process Improvement (SCAMPI) are trademarks, registered 
trademarks or service marks of the Carnegie Mellon University. 

Citrix and MetaFrame are trademarks or registered trademarks of Citrix Systems, Inc. in the United States and other countries. 

dBASE is a registered trademark of dBASE Inc. Other dBASE Inc. product names are trademarks or registered trademarks of dBASE Inc. 

IBM, CIC/MVS, ClearCase, ClearQuest, Database Manager, DB2, DB2 Connect, DB2 Client Action Enablers, ISPF, ISPF/PDF, MVS, Rational, Rational Unified Process, 
RequisitePro, RUP, SQL/DS and WebSphere MQ are registered trademarks or trademarks of International Business Machines Corporation (IBM). 

Intel, Itanium, Pentium and XScale are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries. 

GROOVE NETWORKS, GROOVE, the Groove interlocking circles logo, GROOVE.NET, WORKSPACE and EVERSYNC are trademarks of Groove Networks, Inc. 

MAXIMUS and FleetFocus are trademarks or registered trademarks of Maximus, Inc. 

Microsoft, Windows, ActiveSync, MS-DOS, Visual Basic, Visual C#, Visual C++, Visual SourceSafe, Visual Studio, Windows Mobile, Windows NT, and Windows Server 
are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 

MySQL is a trademark of MySQL AB in the United States and other countries. 

Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications Corporation in the U.S. and other countries. Navigator is also a 
trademark of Netscape Communications Corporation and may be registered outside the U.S. 

Novell is a registered trademark of Novell, Inc. in the United States and other countries. 

Oracle, Oracle8i, Oracle9i, Oracle10g, Oracle Enterprise Manager, OracleMetaLink, and SQL*Plus are trademarks or registered trademarks of Oracle Corporation. 

Palm OS, Graffiti and HotSync are a registered trademarks of Palm, Inc. 

processMax is a registered trademark of pragma Systems Corporation. 

PeopleSoft and the PeopleSoft logo are registered trademarks of PeopleSoft, Inc. 

SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA 
registration. 

Sun, Java and Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. or other countries. 

Sybase, Adaptive Server, Adaptive Server Anywhere, Adaptive Server Enterprise, SQL Server, SQL Advantage, SQL Anywhere, Sybase Central, PowerBuilder, 
PowerDesigner, and Watcom SQL are registered trademarks or trademarks of Sybase Inc. and its subsidiaries. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Other product names are trademarks or registered trademarks of their respective owners. 

Copyright © 2006 by Info Tech, Inc. and the American Association of State Highway and Transportation Officials.  All rights reserved.  This document or parts thereof may 
not be reproduced in any form without written permission of the publisher. 

Printed in the United States of America. (version 20051012) 

 



 Trns•port SiteManager® Learning Guide 
Objectives SiteManager for Management Personnel 

 

 

 iii 

 

Objectives 

In this course, you will learn the following: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 

• View an active Contract 

• View Subcontracts 

• Understand the Basic Concepts of Daily Work Reports 

• View DWR 

• View Diary 

• View In-Box Estimate Message 

• View the Estimate Summary  
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• View Estimate Discrepancies 

• Generate the Summary To Contractor Report 

• Approve Estimates 

• Track Estimates 

• Understand the Rules and Life Cycle of Change Orders 

• View a Change Order Header 

• View Change Order Time Adjustments  

• View Modifications to Contract Items  

• View the Custom Change Order  

• View the Change Order Report 

• Approve Change Orders 

• Track Change Orders 
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Learning Module 

 Section 1  Getting Started 
for Management Personnel 

 

By the end of this module, you will be able to: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager 

components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 

May 2007 
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Using the Student Guide 

The student guides are divided into sections — learning modules. Each learning 
module consists of: 

• Objectives 

• Multiple Topics and Instructor-Led Exercises 

• Review 

• Summary Exercise 

Each section will begin with the objectives for the module. The module will be 
divided into topics roughly corresponding to the objectives of the module. Each 
topic will have a short description of the SiteManager function, one or more 
general procedures about how to perform an action in SiteManager, and an 
instructor-led exercise for the topic. Instructor-led exercises are easy to spot on 
each page. Instructor-led exercises are identified by the Bulldozer graphic 
illustrated below and are numbered sequentially. Instructor-led exercises are 
very explicit and detail the specific steps and data to be used in performing the 
action. 

 Exercise 5-2 
Instructor-led Exercises are identified by the Bulldozer graphic. 

Figure 1-1 

Each module will end with a review and a summary exercise. The review will 
summarize the main points and all of the SiteManager functionality covered in 
the module. The review pages may serve as an excellent reference for the 
summary exercise that follows the review. It may also server as a work aid for 
use back at the office. 

The summary exercise gives you the opportunity to practice the skills you 
learned in the learning module. The summary exercise instructions will provide 
you with the data to be used and general instructions. Remember that the module 
review on the pages immediately preceding the summary exercise is composed 
of the general procedures covered in the module. The review will serve as a 
good reference as you perform the summary exercise. 
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SiteManager Procedures, the steps you follow to access a component of 
SiteManager, vary depending on whether you have just entered the system or 
have been in some other component and have already selected a common 
variable. 

For instance, if you enter the application and navigate directly to the Contractor 
Payments component, the Estimate Summary window requires the selection of 
the desired Contract and Estimate. However, if you have been working in the 
Contract Records component, already have a Contact selected, and then navigate 
to the Contractor Payments component, the Estimate Summary window displays 
the Estimates for the Contract previously selected in Contract Records. 

The procedures in this manual describe how to access components of 
SiteManager as if you just entered the application. 

 

In TDOT, there are three Student Guides: 

• SiteManager for Office Documentation 

• SiteManager for Field Documentation 

• SiteManager for Management Personnel 
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Starting AASHTO SiteManager 
The AASHTO SiteManager Construction Management System will run on several 
different windows graphical User interfaces. For your operating system, you will 
start AASHTO SiteManager the same way you would any program on your 
computer. 

 
SiteManager Desktop Icon 

Figure 1-2 

 

The SiteManager Logon Dialog Box 

Figure 1-3 

 
The Group Dialog Box 

Figure 1-4 

Note. The only RTF template that TDOT uses is The Summary to Contractor Report, 
which is not needed in Standalone mode; therefore, the Download RTF Template check 
box should never be selected. 
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 Exercise 1-1 
In the following exercise, you will log on to SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Start button. 
2. Click the All Programs choice. 
3. Click the SiteManager Training choice. 
4. Click the SiteManager choice. SiteManager displays the 

SiteManager Logon dialog box. 
5. In the User ID field, type jj05753. 
6. Press the Tab key. 
7. In the Password field, type pass. 
8. Press Enter. SiteManager opens with the SiteManager Panel displayed. 
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Main Panel Folder Tab of SiteManager Panel 

After starting the SiteManager application, the Main Panel tab will display the 
components of the system as icons. The central functionality of SiteManager is 
divided into ten icons: Contract Administration, Daily Work Reports, Pipeline, 
Contractor Payments, Change Orders, Civil Rights, Materials Management, 
Accessories, System Administration, and Manuals. 

 

SiteManager Panel Window’s Main Panel Tab 

Figure 1-5 

 

The SiteManager Status Bar 

The SiteManager Status Bar at the bottom of the SiteManager window indicates 
your mode, connection, database region, logon group and individual ID. 

 
Status Bar 

Figure 1-6 
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Navigating in SiteManager Using the Main Panel 

The SiteManager Panel is used to navigate to the components of the 
SiteManager application. The highest level is the Main Panel tab that contains 
the different functional groups, with each group individually represented by an 
icon. Double-clicking the icon of a functional group brings up another folder tab 
consisting of the sub-groups or the actual windows contained within that 
functional group. As icons are selected, the next level’s folder tab appears next 
to the previous level. 

 

Navigating in SiteManager 

Figure 1-7 
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 Exercise 1-2 
In the following exercise, you will browse some of the components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 
1. View the icons on the Main Panel. 
2. On the Main Panel, double-click the Contract Administration icon. 
3. On the Contract Administration panel, double-click the Contract Records 

panel. SiteManager displays the Contract Records panel. 
4. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
5. To go up a level, click the Contract Administration tab. 
6. Double-click the Contractor Management icon. SiteManager displays the 

Contractor Management panel. 
7. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
8. To go up two levels, click the Main Panel tab. 
9. Double-click the Daily Work Reports icon. SiteManager displays the Daily 

Work Reports panel. 
10. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
11. To go up a level, click the Main Panel tab. 
12. Double-click the Pipeline icon. SiteManager displays the Pipeline panel. 
13. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
14. To go up a level, click the Main Panel tab. 
15. Double-click the Contractor Payments icon. SiteManager displays the 

Contractor Payments panel. 
16. On the Contractor Payments panel, double-click the Estimate icon. 

SiteManager displays the Estimate panel. 
17. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
18. To go up a level, click the Main Panel tab. 
19. Double-click the Change Orders icon. SiteManager displays the Change 

Orders panel. 
20. On the Change Orders panel, double-click the Change Order Maintenance 

panel.  
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21. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
22. To go up a level, click the Main Panel tab. 
23. Double-click the Accessories icon. SiteManager displays the Accessories panel. 
24. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
25. To go up a level, click the Main Panel tab. 
26. Double-click the Manuals icon. SiteManager displays the Manuals panel. 
27. Take note of the icons available from the panel. 

Now, to prepare for the next exercise, let’s navigate to the Contract Records panel. 
28. To go up a level, click the Main Panel tab. 
29. Double-click the Contract Administration icon. 
30. Double-click the Contract Records icon. SiteManager displays the Contract 

Records panel. 
31. In the Contract Records panel, double-click the Contracts icon. SiteManager 

displays the Select Contract window. 
32. In the Contract ID list box, scroll to and double-click CNB022C. SiteManager 

displays the Contracts window. 
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 Exercise 1-3 
In the following exercise, you will identify the components of the toolbar. Place 
the mouse over the button and use the tool tip to identify each component. Then 
you will activate the “show text” option. Write the toolbar component name next 
to the appropriate letter below.  

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 

The SiteManager Toolbar 

Figure 1-8 

A  H  

B  I  

C  J  

D  K  

E  L  

F  M  

G    

 
1. Place the mouse pointer on the toolbar. 
2. Use the right-click button to click the toolbar.  
3. In the Object menu, click Show Text. 
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Controlling the Display of Multiple 
SiteManager Components 

In many instances, you will be working in a 
SiteManager component and need to leave it 
temporarily to open another component. Having 
opened more than one component of SiteManager 
you may then need to control the display. 

 
The File Menu 

Figure 1-9 

Opening Multiple SiteManager Components 

While being in one SiteManager component, you may need to go to another 
component without closing the current one. 

 Exercise 1-4 
In the following exercise, you will open one component, while another component of 
SiteManager is open. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

Now, let’s open another SiteManager component. 
1. Click the SiteManager Panel button.  
2. Double-click the Projects icon. SiteManager displays the Projects window. 
3. In the Project Number list box, scroll to and double-click 55019-

3220-94. 
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Using the Window Menu to Control the Display of Multiple 
SiteManager Components 
Having opened more than one SiteManager component, you can now use a variety 
of standard Windows methods to control the display of the components and your 
movement between them.  

CONTROLLING THE WINDOW DISPLAY USING TILE 
Tiling divides the screen into the number of SiteManager components that you 
have active. Typically, tiling is used to display two SiteManager components side 
by side horizontally to compare the entries in each or to return a single component 
to full screen once you have closed the other component. With three components 
of SiteManager active, tiling would give each component only one third of the 
screen. Unless you have a very large display, tiling with more than two 
SiteManager components open may not be very useful. 

The Window Menu 

Figure 1-10 

 
Two SiteManager Components Tiled 

Figure 1-11 

 Exercise 1-5 
In the following exercise, you will tile the two current components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Tile choice. SiteManager tiles the windows. 
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CONTROLLING WINDOW DISPLAY USING CASCADE 
Cascading makes the number of SiteManager components that you have active 
an equal size and arrange each component in an overlapping offset window. 
Typically, cascading is used to display more than two open SiteManager 
components offset. When you have a need to navigate between more than two 
open SiteManager components, the Cascade choice may make it easier to move 
between them. 

 

Three SiteManager Components Cascaded 

Figure 1-12 
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 Exercise 1-6 
In the following exercise, you will open another SiteManager component, cascade the 
open components and navigate among the three. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the SiteManager Panel button. 
2. In the Contract Records panel, double-click the Categories icon. 

Now, let’s cascade the windows. 
4. Click the Window menu. 
5. Click the Cascade choice. SiteManager cascades the windows. 

Now, let’s navigate between the cascaded windows. 
6. Click the visible portion of the Projects window. 
7. Click the visible portion of the Contracts window. 
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CONTROLLING WINDOW DISPLAY USING LAYER 

Layering displays the SiteManager component that you have active in the most 
efficient full screen display. Typically, layering is used to give each active 
component a full window for display or to return a single active component to 
full display after you have closed the other components that were tiled or 
cascaded. 

 
The Window Menu with Three SiteManager Components Active 

Figure 1-13 

 Exercise 1-7 
In the following exercise, you will layer the three open components of SiteManager 
and move between them. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Layer choice. SiteManager layers the windows. 

Now, let’s navigate to another window. 
3. Click the Window menu. 
4. Click the Categories choice. SiteManager displays the Categories window. 

Now, let’s navigate to another window. 
5. Click the Window menu. 
6. Click the Projects choice. SiteManager displays the Project window. 
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Closing Versus Exiting in SiteManager 
While SiteManager is not document oriented like other common Windows 
applications, the same principle of closing versus exiting still applies. When you 
are in a SiteManager component and you wish to end your work in it, but still 
continue to perform other SiteManager activities, you should close. As with other 
applications, you only exit SiteManager when you are through with your 
activities. 

 
The File Menu 

Figure 1-14 

The SiteManager Toolbar 

Figure 1-15 

 Exercise 1-8 
In the following exercise, you will close a component of SiteManager and then exit 
the application. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. To close a window, click the Close button. 
2. To exit SiteManager, click the Exit SiteManager button or click the File menu 

followed by the Exit choice. 
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Changing Your SiteManager Password 
In addition to your network logon identity, SiteManager also has password 
protection. Your SiteManager ID determines what information you have access to 
and whether you can update the data or not. If you have any questions regarding 
your SiteManager security access, contact your SiteManager System 
Administrator. 

 
The Change Password Dialog Box 

Figure 1-16 
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IMPORTANT TIPS REGARDING YOUR USER ID: 

1. In TDOT, when a User ID is first assigned to a User, the default 
password is PASSWORD (all caps). The User must change the 
password before logging on to SiteManager.  

2. SiteManager User IDs for TDOT Criteria: 

• Seven characters in length.  

• The first two characters will be jj (in lowercase), followed by a 
randomly assigned 5-digit number. 

IMPORTANT TIPS REGARDING YOUR SITEMANAGER PASSWORD 
AND LOGON ATTEMPTS: 

1. It is important that you do not give out your password to anyone. 
SiteManager maintains a record of everything you do in 
SiteManager. These records are the same as your signature. 

2. If you have attempted to log on twice and have failed, close the 
SiteManager Logon window and start again. This will allow you to 
try to log on again without disabling your password. 

3. If you attempt to log on three times and fail, SiteManager will 
disable your password. Contact Regional Support if password is 
disabled. 

4. SiteManager Passwords for TDOT Criteria:  

• Four to eight characters in length 

• Case-sensitive - SiteManager can tell the difference between 
capital and lowercase letters. Type your ID and password 
precisely. 

• 90-day expiration 

• Cannot be the word “password” 
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 Exercise 1-9 
In the following exercise, you will log on to SiteManager using another ID and 
change the password.  

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. To select the user ID, hold down the Shift key and press the Tab 

key. 
3. In the User ID field, type jj05750. 
4. To move to the next field, press the Tab key. 
5. In the Password field, type PASSWORD. 
6. Click the Change Password button. SiteManager displays the 

Change Password dialog box. 

Now, let’s change the password. 
7. In the Old Password field, type PASSWORD. 
8. Press the Tab key. 
9. In the New Password field, type pass. 
10. Press the Tab key. 
11. In the Confirm Password field, type pass. 
12. Click OK.  

 



Trns•port SiteManager® Learning Guide Security Overview 
Section 1  Getting Started SiteManager Overview for TDOT 
 

 

20  

Security Overview 
Depending on your SiteManager security privileges, you may have: 

• Update rights to all SiteManager windows and data, 

• Inquiry rights only and be able to access data and print reports, but 
not update information, 

• Update rights on some SiteManager windows, inquiry only on 
other windows, and/or no access to other windows,  

• Update rights on some SiteManager data, inquiry rights on other 
data, and/or no access to other data, 

• Access to SiteManager in only a network mode, or 

• Access to SiteManager in both a standalone and network mode. 
When you have access to the window and the data, the field will appear with a 
white background. When you only have inquiry access, the data will appear but 
the fields will have a gray background. 

 

A SiteManager Window in Inquiry Only Mode 

Figure 1-17 
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 Exercise 1-10 
In the following exercise, you will access an inquiry only window in server mode as 
well as log into the application in standalone mode to view the difference in security 
options. 

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. How many icons are displayed on the Main Panel? ________________ 
2. Double-click the Contract Administration icon. 
3. Double-click the Contract Records icon. 
4. How many icons are displayed on the Contract Records panel? 

_________________________________________________________ 
5. Double-click the Categories icon. 
6. Double-click Contract CNB022C. 
7. Double-click Project Number 55019-3220-94. 
8. Does the screen display in inquiry or update mode?  ________ 
9. Click the Exit SiteManager button. 

Now, let’s log on using a different user ID and see how the access rights for that user 
affect the icons available. 

User ID: jj05753 Group: PJSUPS Mode: Standalone 
10. Double-click the SiteManager Training program icon. 
11. To select the User ID, hold down the Shift key and press the Tab key. 
12. In the User ID field, type jj05753. 
13. In the Connect to drop-down list, click the expand arrow to the right of the 

current selection and click the Training Standalone choice. 
14. In the Password field, type pass. 
15. Click the Logon button. 
16. How many icons are on the Main Panel? _________________________ 
17. On the Main Panel, double-click Contract Administration.  
18. On the Contract Administration panel, double-click the Contract 

Records icon. 
19. How many icons are displayed on the Contract Records panel? _______ 
20. Click the File menu. 
21. Click the Exit choice.  
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Now, to prepare for the next exercise, let’s log on using a different user ID. 

User ID: jj05754 Group: OSTAFF Mode: Server 
22. Double-click the SiteManager Training program icon. 
23. Hold down the Shift key and press the Tab key. 
24. In the User ID field, type jj05754. 
25. Press the Tab key. 
26. In the Password field, type pass. 
27. Press Enter. 
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Entering a SiteManager Window – Open, New, and 
Choose Keys 

When you have the authority and update rights and first enter a SiteManager 
window, you can: 

• Open for an existing record , or 
• Create a new record for data entry, 
• Choose keys to create a new record. 

In some instances, SiteManager will not even let you into the window without 
choosing the keys first. Choosing the keys identifies the initial values for the 
new or existing record. 

 
 

Opening an Existing Record 

When opening an existing record, it is not necessary to use the Choose Keys 
option. For some windows, a selection list will be automatically displayed to 
allow the User to select the appropriate record. For other windows, the User may 
access records by selecting the Open button and choosing the appropriate record. 

 Exercise 1-11 
In the following exercise, you will access a window and open an existing record that 
needs multiple keys. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the Main Panel tab, double-click the Daily Work Reports icon. 
2. On the Daily Work Reports tab, double-click the Daily Work 

Reports icon. 
3. What security mode are we in (inquiry or update)? ______________ 
4. What Contract ID is displayed? _____________________________ 
5. On the toolbar, click the Open button. 
6. In the Contract list box, scroll to and double-click contract ID 

CNB022H. 
7. In the Inspector list box, scroll to and double-click user ID jj05751. 
8. In the Date list box, scroll to and double-click DWR date 04/20/05. 
9. When informed that the DWR will be opened in read-only format, 

click the OK button. 
10. When you want to open an existing record, do you use Open, New, 

or Choose Keys? _________________________________________ 
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Creating a New Record 

When creating a new record, the User will navigate to the appropriate window. 
For some windows, the window will open in New mode. For other windows, the 
User may create a new record by selecting the New button. 

 Exercise 1-12 
In the following exercise, you will access a window and identify the new record 
mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the toolbar, click the New button. 
2. Note that you are ready to create a record for Contract CNB022H. 
3. What is the Inspector’s Name? ____________________________ 
4. What is the DWR date? __________________________________ 
5. What is the Contract? ____________________________________ 
6. When you want to create a new record, do you use Open, New, or 

Choose Keys? __________________________________________ 
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Choosing Keys 

The Choose Keys choice displays a list of key field(s) to be selected. In many 
instances in SiteManager, the Choose Keys choice must be selected before a 
new record can be created. 

 
Choosing Keys 

Figure 1-18 

 

 Exercise 1-13 
In the following exercise, you will access a window that requires keys to be chosen 
and identify the new record mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. Click the Services menu. 
2. Click the Choose Keys choice. SiteManager displays the Contract 

ID window. 
3. In the Contract ID list box, scroll to and click the CNB022C choice. 
4. Click the OK button. 
5. Note that you are ready to create a record for Contract CNB022C. 
6. When you want to create a new record for a DIFFERENT Contract, 

do you use Open, New, or Choose Keys? ______________________ 
7. Click the Close button. 
8. Click the No button when prompted to save changes. 
9. Click the Main Panel folder tab. 
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Using the Object Menu for Data Manipulation and 
Retrieval 
To make data entry and retrieval easier, SiteManager provides a Search, Filter, 
Find, and Sort capability throughout the application. The Filter and Find 
functions also provide Users with the ability to limit the data retrieved from the 
SiteManager database by specifying criteria using relational operators. The Clear 
button removes the current data retrieval choice in effect. The Show Filter/Sort 
choice shows the current criteria in effect for these choices. 

To invoke the Object menu, using the right mouse button, click in a field. 

 
The Object Menu 

Figure 1-19 

 

Criteria Window Buttons: 

Insert:  Inserts a blank row before the currently selected row.   

Add:  Inserts a blank row after the last row. 

Remove:  Deletes the selected row.  Remove deletes only one row at a 
time. 

Clear: Deletes all rows.  All rows must be deleted to return to the 
complete, unfiltered list. 

Load: Opens saved filter list.  Saved filter allows for loading and 
deleting of saved (and default) filters. 

Save: Opens filter name window to allow filter to be saved.  The 
Default check box allows a filter to be automatically applied every time 
the window is accessed. 
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Criteria Window Conditions: 

Using the Equal (=) condition: 

• Requires the specified value to be exact.  

• Only matching whole words will be included 

• Only matching capitalization will be included 

Using the Like condition: 

• Allows specified value to be imprecise 

• Wildcard % allowed – A wildcard is a value that matches any value 
– like the wild card when playing Uno. 

• SiteManager assumes value% when the Like condition is selected, 
including all data that start with the entered value 

• %value% allows partial data matches to be included  

• Only matching capitalization will be included 

When creating multiple conditions, AND joins will be executed before OR 
joins. 
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Sorting 

When the window displays as a list, the Sort feature allows you to sort the list, 
based on specified criteria. Each time the window displays, the default sort 
criterion is automatically applied. As with the Filter function, only one default 
sort criterion can be in effect for a window at any given time. 

 
The Sort Window 

Figure 1-20 
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 Exercise 1-14 
In the following exercise, you will sort the Work Items records for a DWR for 
Contract CNB022E. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. In the Main Panel, double-click the Daily Work Reports icon. 
2. In the Daily Work Reports panel, double-click the Daily Work 

Reports icon.  
3. In the Daily Work Reports window, click the Open button on the 

toolbar. 
4. Click the No button in the Save Message. 
5. In the Contract ID list box, scroll to and double-click CNB022E. 
6. In the Inspector ID list box, scroll to and double-click jj05752, 

Sandy Gutierrez. 
7. In the DWR Date list box, scroll to and double-click 04/04/05. 
8. Click the OK button to the Read Only message. 
9. Click the Work Items folder tab. 

Now, let’s use the column headings to sort the Work Item list. 
10. Click the Description column heading. 
11. Click the Item Code column heading. 
12. Click the Instld column heading. 
13. Scroll to the bottom of the list to see the items that were reported 

installed on this DWR. 

Now, let’s use the Object Menu to sort. 
14. Position the pointer over the first record. 
15. Use the right-click button click the record.  
16. In the Object menu, click Sort. 
17. In the Sort Criteria window, click the Add button.  
18. In the Field drop-down list, click ProjectNumber 
19. Click the Add button, again. 
20. In the Field drop-down list, click Item Code. 
21. Click the OK button. 
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Finding 

When a window displays as a scrollable list, the Find choice allows the User to 
get to a specific row by selecting the appropriate value to find. 

 
The Find Criteria Window 

Figure 1-21 
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 Exercise 1-15 
In the following exercise, you will locate an item using the Find option.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over the first record in the list at the top 

of the window. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Find choice. SiteManager displays the 

Find Criteria window. 
4. On the Find Criteria window, click the Add button. 
5. In the Field drop-down list, click Item Code. 
6. In the Condition drop-down list, click =. 
7. In the Value field, type 712-06. 
8. Click the Add button. 
9. In the Field drop-down list, click ProjectNumber. 
10. In the Condition drop-down list, click =. 
11. In the Value field, type 55019-3220-94.  
12. Click the Find button.  
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Filtering 

The Filter choice allows you to specify filtering criteria for SiteManager fields 
and their limiting values using relational operators. Each time a window 
displays, the filtering criteria, marked as default, is automatically applied, 
thereby limiting the amount of data retrieved. Only one default filter criterion 
can be in effect for a window at any given time. 

 
The Filter Criteria Window 

Figure 1-22 
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 Exercise 1-16 
In the following exercise, you will learn how to filter to display only the records 
meeting your condition.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 

Now, let’s filter the contents of this list. 
1. Position the selection pointer over a record in the list at the top of the 

window.  
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. Click No to the Save Changes prompt. 
5. In the Filter Criteria window, click the Add button. 
6. In the Field drop-down list, click Description. 
7. In the Condition drop-down list, click Like. 
8. In the Value field, type %CONCRETE%. 
9. Click the OK button. 
10. When informed that the specified filter will return a number of rows, 

click the Ok button.  The Work Items window displays the filtered 
results. 
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Clearing the Current Criteria 

Remember that the current data retrieval choice will stay in effect until cleared. 
The Clear button removes the current data retrieval choice in effect by deleting 
all of the rows of criteria, which returns unfiltered results. 

 Exercise 1-17 
In the following exercise, you will clear the current filter. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over a record. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. In the Filter Criteria window, click the Clear button. 
5. Click the OK button. SiteManager displays a message. 
6. When informed that the specified filter will return a number of rows, 

click the OK button. The Work Items window displays all of the 
rows without filtering the results. 

7. Click Yes to the Filter Message. 
8. Click the Close button on the toolbar. 
9. Click the Main Panel folder tab. 
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System Attachments 
The System Attachments window allows URL links, Plug-In applications, and OLE 
attachments to be attached the SiteManager system without being attached to 
specific records.  Plug in and OLE attachments are detailed in other sections of this 
training manual. 

 

The System Attachments Window  

Figure 1-23 

 
The CMS File Management System Attachment 

Figure 1-24 

 

 
In TDOT, URL links are included as System Attachments. 

The CMS Contract File Management attachment will open the File 
Management system.  The URL this attachment opens is as follows.  

\\jj00wf080\cms\ 
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 Exercise 1-18 
In the following exercise, you will view System Attachments. 

User ID: jj05754 Group: OSTAFF 
1. On the Main Panel, double-click the Accessories icon.  
2. Double-click the System Attachments icon.  
3. In the System Attachments list box, scroll to and click CMS 

Contract File Management. 
 

The System Attachments are not set up for the training environment.   
 
4. Click the Close button.  
5. Click the Main Panel folder tab. 
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Support Resources 

The following Support Resources have been developed for AASHTO 
SiteManager. Contact your SiteManager System Administrator to verify your 
Transportation agency policies regarding the availability and distribution of this 
material. 

• User Manual (.pdf) 
• SiteManager On-line Help 
• Learning Guides 
• Training Database 
 

TDOT SiteManager Support Personnel 

Location Name Email Phone 

Bobby Henegar Bobby.Henegar@state.tn.us (865) 594-4511 Region 1 

Jane Peterson Jane.Peterson@state.tn.us (865) 594-2351 

Region 2 Gail Hollis Gail.Hollis@state.tn.us (423) 949-9202 

Region 3 Gwen Ward Gwen.Ward@state.tn.us (931) 684-0797 

Dan Robinson Dan.Robinson@state.tn.us (731) 935-0220 Region 4 

Chrystal Cochran Chrystal.Cochran@state.tn.us (731) 935-0221 

HQ Chris Hampton Chris.Hampton@state.tn.us (615) 741-3542 

 

In TDOT, electronic documentation and on-line training material can be 
obtained from Support Personnel as needed or downloaded from 
\\jj00wf080\CMS\HQ\Construction\SiteManager Reference Guides. 
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Using Help 

The Help menu will contain standard Help choices — Contents, Search for Help 
on, and Glossary and, when accessed while a window is open, will also provide 
one non-standard choice, Current Window. Help in SiteManager will work like 
any other Windows Help. 

Using Help by Contents 

The Help menu’s Contents choice or the Help button 
displays an alphabetized list of Help Topics that can 
be browsed for the subject on which you need help. 

 
Help Contents 

Figure 1-25 

 
Help Button 

Figure 1-26 
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 Exercise 1-19 
In the following exercise, you will access Help from the Help menu. 

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, click the Help menu. 
2. Click the Contents choice. SiteManager displays the AASHTO 

SiteManager Help window. 
3. On the Contents page, scroll to the Contracts Panel section and 

click the Contracts Description Folder Tab topic. 
4. Click the Status-Contract Description tab link. Help displays a 

pop-up window. 

Now, let’s exit online Help. 
5. To close the Help window, click the File menu and click the Exit 

choice. 
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Using Help by Searching 

The Search for Help on choice displays a lengthy, alphabetized list of Help 
Topics that can be browsed or searched for the subject on which you need help. 

 
The Help Search 

Figure 1-27 

 Exercise 1-20 
In the following exercise, you will search for a topic.  

User ID: jj05754 Group: OSTAFF 
1. Click the Help menu and click the Search for Help on choice.  
2. Click the Search button.  
3. Type stockpiled materials. 
4. Click the Stockpiled Materials Panel topic. 
5. Click the Display button. Help displays the requested topic. 
6. To close the help window, click the File menu and click the Exit choice. 
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Using the Current Window Help 

With any SiteManager window active, the Help menu’s Current Window choice 
will access context sensitive help that includes Help on fields. 

 
The Help on a SiteManager Window 

Figure 1-28 
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 Exercise 1-21 
In the following exercise, you will access Help on the current window. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. On the Main Panel, double-click the Contract Administration 

icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Contracts icon.  

Now, let’s open another contract. 
4. Click the Open button. 
5. In the Contracts list box, scroll to and double-click Contract 

CNB022C. 
6. Click the Help menu and click the Current Window choice 
7. Click the Next Page (>>) button (right arrow at the bottom center of 

window). 
8. In the Contract Description tab Field Names and Descriptions 

section, click Contract ID – Contract Description tab. Help 
displays a pop-up window. 

Now, let’s exit online Help. 
9. Click the File menu and click the Exit choice. 

Now, let’s prepare for the next exercise. 
10. To close the Contracts window, click the Close button. 
11. Click the Main Panel folder tab. 
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Viewing the User Manual 

The SiteManager User Reference Manual is a reference document for users of 
the AASHTO SiteManager application.  The user should refer to this manual 
only when a question cannot be answered by referring to the SiteManager online 
help system.  This manual describes all of the SiteManager components, 
including their purpose, functions, and how to use them. 

 
The User Reference Manual in PDF 

Figure 1-29 
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 Exercise 1-22 
In the following exercise, you will access the on-line User Reference Manual.  

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, double-click the Manuals icon. 
2. Double-click the User Manual icon. 
3. Click the Next Page button. (At the bottom, this looks like a triangle.) 
4. Click the page number field at the bottom of the screen. 
5. Type 25. 
6. Press Enter.  

Now, let’s search the reference manual. 
7. Click the Search button.  (In the toolbar, this looks like binoculars.) 
8. In the Search for field, type Temperature. 
9. Click the Search button. 
10. Click the first result. 
11. Click additional results to browse the topic. 

Now, let’s exit the application. 
12. Click the File menu. 
13. Click the Exit choice. 

Now, let’s prepare for the next exercise. 
14. Click the Main Panel folder tab. 
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Standard SiteManager Reports 

Below is a list of the standard SiteManager Reports and the SiteManager panels 
they may be selected from. 

Contract Administration: 

• Contract Status  

• Item Quantity 

• Item Work Report 

• Subcontract Value 

• Contractor Current Status 

• Past History – Work Completion 

Contractor Payments:  

• Summary To Contractor    

• Installed Work  

• Work Suspend/Resume Times 

Change Orders:  

• Change Order Report    

• Unapproved Change Order Aging Report 

• Time Extension Granted    

• Change Order/Reason Code Breakdown   

 

TDOT has created several custom reports in Crystal Reports. The custom 
reports are run from a separate application accessed through the internet. 

                                                      

  This is run from the Process List window. 
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General Reporting Concepts 
Most reports follow these procedures. The user initiates the report from the 
correct report window.  

 

The Installed Work Report 

Figure 1-30 

To view and print a displayed report: 
1. To view, click the Next Page or Prior Page icons. 
2. Click the Zoom button to reduce the Zoom. 
3. To print, click the Copies button, setting the desired number of 

copies to print. 
4. Click the File menu and click the Print choice. 

To Export a report: 
1. Run the report (saved reports may not be exported) 
2. Click the Services menu Export choice. 
3. In the File Name field, type the file name. 
4. In the Save as type drop-down list, select the type of file: Text, 

Excel, or Lotus 1-2-3. 
5. Click the Save button. 

A Report can be saved for later retrieval. SiteManager saves the report using a 
.PSR extension.  To save a report: 

1. On the toolbar, click the Save button. 
2. In the File Name field, type the name for the file. 
3. Change the drive and directory as desired. 
4. Click the Save button.  
5. In the message box, click the OK button. 
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The View Saved Reports icon can be used to open a saved report. To open a 
saved report: 

1. On the Reports panel, double-click the View Saved Reports (PSR) 
icon. 

2. Change the drive and directory as needed to select the PSR file. 
3. Click the OK button. 

 Exercise 1-23 
In the following exercise, you will access a standard report and save a copy of the 
report.  

User ID: jj05754 Group: OSTAFF Contract: CNB022K 
1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Reports icon. 
3. On the Reports panel, double-click the Installed Work icon. 

SiteManager displays the Report Criteria window. 
4. In the list box, scroll to and double-click the CNB022K choice. 
5. Review the Report.  

Now, let’s save the report to your computer. 
6. Click the Save button. 
7. In the C:\SMTRAINS directory, double-click the SMFILES folder. 
8. Type INWK_CNB022K20061025. 
9. Click the Save button. SiteManager displays a dialog box to inform 

you about exporting the file. 
10. In the dialog box, click the OK button. 
11. To close the Installed Work window, click the Close button. 

Now, let’s view the report you saved to your computer. 
12. On the Reports panel, double-click the View Saved Reports (PSR) 

icon. 
13. Double-click the INWK_CNB022K20061025.PSR file. 

SiteManager displays the View Saved Reports (PSR) window. 

Now, let’s prepare for the next exercise. 
14. Click the Close button. 
15. Click the Contractor Payments tab. 
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Running a Process 
The Process List window in the Contractor Payments panel includes the 
Summary to Contractor Report.  This is the only SiteManager Process that TDOT 
users will need to run. 

A process is run from the Process List window by clicking on the named process, 
and choosing Run Process from the Services menu, or by clicking the named 
process and clicking the Run Process button or by double-clicking the process. 

 

The Contractor Payments Process List window 

Figure 1-31 
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 Exercise 1-24 
In the following exercise, you will run a process. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Contractor Payments panel, double-click the Process List 

icon. 
2. In the Process List, double-click the Summary to Contractor 

report. SiteManager displays the Confirm Process Submission 
window. 

3. Click the Parameters button. SiteManager displays the Process 
Submission Parameters window. 

4. On the Process Submission Parameters window, click the Generate 
Online check box (ON). A warning will appear, noting that the latest 
RTF objects were not downloaded from the Object Store. 

5. On the warning message, click OK. 
6. On the Process Submission Parameters window, click OK. 

SiteManager closes the window. 
 

STOP. Do not submit the process in SiteManager Training.  
 
7. Click the Cancel Button 
8. Click the Close Button. 

 
A copy of the report is saved at C:\SMTRAINS\SMFILES to view during training.  
 
9. Right-click the Start button at the bottom left of the screen. 
10. Click the Explore choice. 
11. Navigate to the C:\SMTRAINS\SMFILES folder. 
12. Double-click Estimate Summary to Contractor CNB022P.htm. 
13. After viewing report, click the Close button to close the browser window. 
14. Click the Exit button to exit SiteManager. 
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Accessing TDOT Custom Reports 

When accessing the TDOT Custom reports, Office Staff users may pick from 
the available reports. 

 
TDOT Office Staff available reports window - page 1 

Figure 1-32 
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TDOT Office Staff available reports window - page 2 

Figure 1-33 

 

TDOT Custom Reports are accessed through the following web address: 

http://jj00wa272/businessobjects/Enterprise115/InfoView/main.aspx 
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Review for Section 1 
To start SiteManager: 

1. Double-click the SiteManager desktop icon. 
Or 
1. Click the Start button, click the Program 

choice, click the SiteManager choice, and 
click the SiteManager choice.  

2. Type your logon identification name. 
3. Press the Tab key. 
4. Type your password. 
5. If appropriate in the Connect to drop-down 

list, click the expand arrow to the right of 
the current selection and click the desired 
database choice. 

6. Press Enter.  
7. If appropriate, in the Available Group for 

… dialog box, click the group ID. 

To select a main panel component of SiteManager: 

1. Double-click the component’s icon 

To select up or down a level in SiteManager: 

1. Click the level’s folder tab. 

To open more than one component of SiteManager: 

1. Open the first component of SiteManager. 
2. Click the SiteManager Panel button. 

Or 
Click the File menu and click the Main 
Panel choice. 

3. Open the other component of SiteManager. 

To tile: 

1. Open the number of SiteManager 
components that you want to tile. 

2. Click the Window menu. 
3. Click the Tile choice. 

To cascade: 

1. Open the number of SiteManager 
components that you want to cascade. 

2. Click the Window menu and click the 
Cascade choice. 

3. Click the visible portion of the window you 
want to display. 

To layer: 

1. Open the number of SiteManager 
components that you want to layer. 

2. Click the Window menu and click the 
Layer choice. 

To move between multiple layered SiteManager 
components: 

1. Click the Window menu. 
2. Click the name of the SiteManager 

component from the list. 

To close a SiteManager component: 

1. Click the Close button. 
Or 
1. Click the File menu and click the Close 

choice. 

To exit SiteManager: 

1. Click the Exit button. 
Or 
1. Click the File menu and click the Exit 

choice. 

To change your password: 

1. Start SiteManager. 
2. On the logon screen, type your existing 

password. 
3. Click the Change Password button. 
4. Type your old password. 
5. Press the Tab key. 
6. Type your new password. 
7. Press the Tab key. 
8. Type your new password, again. 
9. Click OK. 
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To open an existing record:  

1. Double-click the window’s icon. 
2. Click the Open button. 
3. Scroll to and click the desired record. 
4. Click OK  

To create a new record:  

1. Double-click the window’s icon. 
2. Click the New button. 

To choose keys after you enter a window:  

1. Click the Services menu and click the 
Choose Keys choice. 

2. In the list box, scroll to and double-click 
desired value. 

3. Repeat step 2 until all initial values are 
selected. 

To sort records: 

1. Click the desired sort field at the top of the 
list. 

Or 
1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Sort choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Order drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. To add additional sorts, click the Add 
button. 

8. Repeat steps 4-7 until you have selected all 
sorts. 

9. Click OK.  

To find specific records: 
1. Position the selection pointer over a record.  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Find 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  

To filter records: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  
To clear a filter: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Clear button. 
5. Click OK.  
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To view System Attachments: 

1. Double click the Accessories icon. 
2. Double-click the System Attachments icon. 
3. Double-click the attachment you wish to 

run. 

To access Help by Contents: 

1. Click the Help menu and click the Contents 
choice. 
Or 
Click the Help button. 
Or 
In a SiteManager window, press the F1 key. 

2. In the topics list box, scroll to and click the 
desired topic. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help by searching: 

1. Click the Help menu and click the Search 
for Help on choice.  

2. Type the topic on which you need help. 
3. Click the topic. 
4. Click the Display button.  
5. When finished, click the File menu and 

click the Exit choice. 

To access Help on the current window: 

1. Display the SiteManager window for which 
you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help on a field: 

1. Display the SiteManager window that has 
the field for which you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. In the field list, scroll to and click the 
desired field. 

4. When finished, click the File menu and 
click the Exit choice. 

To access the User Manual documentation: 

1. On the Main Panel, double-click the 
Manuals icon.  

2. Double-click the User Manual icon. 

To generate any report: 

1. Double-click the desired report icon. 
2. Select the criteria. 
3. Click OK. 

To save a report: 

1. Click the Save button. 
2. Type the name for the file. 
3. Change the drive and directory as desired. 
4. Click Save. 
5. Click OK. 

To open a saved report: 

1. Double-click the View Saved Reports 
(PSR) icon on the Reports Tab. 

2. Change the drive and directory as needed. 
3. Select the PSR file. 
4. Click Open. 

To run a process: 

1. Navigate to the panel where the process is 
assigned. 

2. Double-click the Process List icon. 
3. In the process list, double-click the desired 

process. 
4. Click the Submit button. 

To access TDOT custom reports: 

1. Launch Internet Explorer.  
2. Access web address 

http://jj00wa272/businessobjects/Enterpri
se115/InfoView/main.aspx.  

3. Click the plus sign next to Public Folders.  
4. Click the plus sign next to SiteManager.  
5. Click the desired group name.  
6. Click the desired report name.  
7. Enter the desired prompt values.  
8. Click the OK button.  
9. Print or Save the report as appropriate.  
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Summary Exercise for Section 1 
In the following summary exercise, you will navigate through SiteManager. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 

1. Log into SiteManager as jj05754. 

2. Navigate to the Items window  
(Main Panel > Contract Administration > Contract Records > Items).  

3. Select the first project for Contract CNB022C, and then any of the available items. 

4. Are you in inquiry or update mode?  ______________________________________________ 

5. Click the Close button to close the Items window.  

6. Navigate to the Item Master window  
(Main Panel > Contract Administration > Reference Tables > Item Master). 

7. Use the Find feature to find the Item Code 204-06 for Spec Year 2000.  

8. What is the Item Description? ____________________________________________________ 

9. Filter for short description %CLEARING%. 

10. What is the first item retrieved? ___________________________________________________ 

11. Clear the filter. 

12. Click the Close button to close the Item Master window.  

13. Navigate to the Milestones window (Contract Administration > Contract Records > Milestones). 

14. Access Help on the current window. 

15. Click the Close button to close the Milestones window. 

16. Navigate to the User Manual and find the Estimate Generation topic.  

17. Click the Close button to close the User Manual window.  

18. Navigate to the Contractor Payment Reports panel.   
(Main Panel > Contractor Payments > Reports) 

19. In Contractor Payment Reports, run an Installed Work Report for contract CNB022L. 

20. In Contractor Payments, navigate to the Process List. 

21. Exit SiteManager. 
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Learning Module 

 Section 2  Contract Administration 
for Management Personnel 

 

By the end of this module, you will be able to: 

• View an active Contract 

• View Subcontracts 

May 2007 
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New Contracts 

This module describes the Contract information available to you through 
SiteManager’s windows and data entry fields. New Contracts are typically loaded 
electronically from the pre-construction system, PES and LAS, and given 
pending status by default.  

 

The Contract Records Panel  

Figure 2-1 

 

To begin tracking the progress of the Contract work in SiteManager, the 
Headquarters Finance Office will change the Contract’s status to active. 
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 Exercise 2-1 
In the following exercise, you will navigate to the Contract window.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05757. 
3. Press the Tab key. 
4. In the Password field, type pass.  
5. Press the Enter key. 
6. In the Available Groups for jj05757 list, double-click DCONREP. 
7. On the Main Panel folder tab, double-click the Contract 

Administration icon. 
8. On the Contract Administration folder tab, double-click the 

Contract Records icon. 
9. On the Contract Records panel, double-click the Contracts icon. 
10. In the Contract ID list box, scroll to and double-click Contract ID 

CNB022E. 



Trns•port SiteManager® Learning Guide Viewing a Contract 
Section 2  Contract Administration SiteManager for Management Personnel 

 

 

60  

Viewing a Contract 

The Description folder tab of the Contract window displays the basic Contract 
description data. This includes the Contract’s status, project number(s), 
administrative offices, and other descriptive information that determines how the 
system processes data for this Contract.  

Contract Time Charges 

In SiteManager, the three types of Time Charges for Contracts AND Milestones 
are: 

• Completion Date - Similar to TDOT “Calendar Days” contracts for non-
resurfacing and non-mowing contracts.  In SiteManager, TDOT Mowing, 
Litter Removal, and Sweeping & Drain cleaning contracts are 
Completion Date.    Time cannot be suspended on Completion Date 
Contracts. 

• Calendar Day - TDOT’s Resurfacing Contracts (Completion Date 
contracts with a working window) are Calendar Day in SiteManager, 
with a set number of bid days.  Time is started when the Notice to 
Proceed date is entered. Milestones noted in special provision 108B, such 
as phased construction and mowing and litter cycles, are also Calendar 
Date time.  Time cannot be suspended on Calendar Day Contracts. 

• Available Work Days - Similar to TDOT’s Working Days.  Time is 
charged on a daily basis in the SiteManager Diary window. 

 

The Description Folder Tab 

Figure 2-2 
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In TDOT, most of the fields on the Contract window are loaded from PES 
and LAS and will not be modified in SiteManager except by the 
Headquarters Construction and Finance Offices. 

TDOT will primarily use the Completion Date Contract Time Charge type. 

 Exercise 2-2 
In the following exercise, you will view the description for new active Contract 
CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. What region and unit is this contract assigned to? 
______________________________________________ 

2. How is time calculated on this contract? 
______________________________________________ 

3. What is the value of this contract? __________________ 
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Viewing the Contract Location 

The Location folder tab displays the Contract location. Each Contract must have 
one county selected as the primary county. 

 

The Location Folder Tab 

Figure 2-3 

 Exercise 2-3 
In the following exercise, you will view the location for Contract CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Location folder tab. 
2. What is the Primary County of Contract CNB022E? _____________ 
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Viewing Contract Payment Data 

The Payment Data folder tab can be used to automatically calculate common 
construction computations. 

 

The Payment Data Folder Tab 

Figure 2-4 

 

In TDOT, the functions of this window will not be used. 

 Exercise 2-4 
In the following exercise, you will view the payment data for Contract 
CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Payment Data folder tab. 
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Viewing Critical Dates 

The Critical Dates folder tab displays Critical Dates in the life of the contract. 
The Critical Date types were defined during system development and cannot be 
added or deleted. These dates are considered critical because SiteManager 
includes them in the standard Contract reports. When a new Contract is added 
from the pre-construction system, PES and LAS, SiteManager includes the 
Critical Date types defined in the Default Critical Date reference table. A few of 
the dates, such as Letting Date, come over from the pre-construction system.  

When an Actual Date is entered, the system can send notices to an individual 
recipient.  

In SiteManager, the Notice to Proceed date is important because: 

• It must be entered before any Estimates may be generated 

• It starts charging time against the contract for Fixed Completion Date 
contracts 

 

The Critical Dates Folder Tab 

Figure 2-5 

 

In the TDOT, the Critical Dates folder tab is updated by the Headquarters 
Construction and Finance Offices. 

In TDOT, the Notice to Proceed is updated by the Headquarters Finance 
Office when the Starting Notice Report is received from the Office Staff. 
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SiteManager  
Critical Date Name 

TDOT Term (if applicable) 
 

Accepted Date Final Inspection Date 

Adjusted Completion 
Date 

Prorata Date – The original completion date altered 
by a Change Order (Supplemental) plus time 
adjustment for item overruns/underruns. 

Assigned to FM Date N/A 

Award Date Award Date  

Checked Out to Field Date System populated when the contract is pipelined out 
to standalone. Changed back to zero when checked 
back in. 

Commissioner Approved 
Completion Date 

The original completion date altered by a Change 
Order (Supplemental). 

Contract Archived Date N/A 

Contractor Bankruptcy 
Date 

N/A 

Contractor Default Date N/A 

Contractor Final Release 
Date 

Claim Expiration Date (Advertisement Due Date) 

Execution Date Accepted Date  

Letting Date Letting Date 

Notice to Proceed Date Effective Date or Work Begin Date (whichever is 
earlier). Time charges start on this date.  For SP 
108B Resurfacing, this is the begin date or at least as 
early as the number of days required before the 
original completion date. 

Open to Traffic Date N/A 

Original Completion Date The completion date established by the contract. 

Price Adjustments Base 
Date 

Auto-populated with first day of letting’s month 
(even if no price adjustment exists) 

Physical Work Complete 
Date 

N/A 

Signed Date Signed Date 

Substantial Work 
complete date 

Date to Stop Charging Time (for Completion Date 
contracts) 

Work Begin Date Date Work Actually Began (Starting Notice) 

The TDOT Equivalents to Default Critical Dates 

Table 2-1 
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 Exercise 2-5 
In the following exercise, you will view the Actual Date of a Contract Critical 
Dates for Contract CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Critical Dates folder tab. 
2. In the Critical Date Description list box, scroll to and click Notice 

to Proceed Date. The data for the Notice to Proceed Date is 
displayed below the list. 

3. What is the Notice to Proceed Date ? _______________________ 
4. What is the Original Completion Date?_____________________ 
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Viewing Contract Primary Personnel 

The Primary Personnel folder tab displays Contract’s primary State personnel. 
Every Contract must have a Project Manager and a Project Engineer. When a 
user is designated as the Project Manager and/or Project Engineer on the 
Contract, SiteManager adds that user to Contract Authority automatically. If 
primary personnel are later replaced, SiteManager starts authority for the new 
personnel and ends authority for the previous personnel.  

The terms Project Manager and Project Engineer are SiteManager terms and have 
no particular significance other than the fact that they are the first two to receive 
Contract Authority. 

 

The Primary Personnel Folder Tab 

Figure 2-6 

 

At TDOT, the Headquarters Construction Office will enter the assigned 
Project Supervisor in both the Project Manager and Project Engineer field.  

 Exercise 2-6 
In the following exercise, you will view the Project Manager and Project 
Engineer assignments for contract CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Primary Personnel folder tab. 
2. Who is the Project Supervisor for Contract CNB022E? 

_________________________________________________ 
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Viewing the Prime Contractor and Associates 

The Prime Contractor folder tab displays the Prime Contractor, the Prime 
Contacts, and the Prime Associates. At a minimum, SiteManager requires a 
Prime Contractor, Surety company, and Insurance company to be designated. 

 
The Prime Contractor Folder Tab 

Figure 2-7 

Since TDOT does not record an insurance company for the prime 
contractor, the placeholder value, SiteManager Generic Insurance, is 
substituted for a real value. TDOT will record actual associates for: 

• Bonding 
• Surety 

 Exercise 2-7 
In the following exercise, you will view the Prime Contractor’s surety and insurance 
companies for Contract CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Prime Contractor folder tab. 
2. Who is the Prime Contractor? _______________________ 
3. Who is the Bonding Company? 

_______________________________________________ 
4. Who is the Surety Company? 

_______________________________________________ 
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Viewing the DBE Commitment Goal 

The DBE Commit folder tab displays the DBE commitments for a Contract. If 
the Prime Contractor is a DBE, the User can also enter the DBE Work Class on 
this folder tab. The system calculates the DBE commitment amounts displayed 
on this folder tab using values entered on the Subcontracts panel. 

 

The DBE Commitment Folder Tab 

Figure 2-8 

 Exercise 2-8 
In the following exercise, you will view the DBE goal.   

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the DBE Commit folder tab. 
2. What is the DBE Commitment Total Current Pct?______________  
3. Click the Close button. 

 

The Training Plan Folder Tab 

The Training Plan folder tab is grayed out because it is obsolete functionality 
deactivated by AASHTO. 
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Viewing a Subcontract 

The Subcontract panel lets the User add, modify, and delete Subcontracts and 
Subcontract data. The panel also displays calculated DBE commitment amounts. 
The User can define both parent Subcontracts and lower level Subcontracts. 

 
The Subcontracts Description Folder Tab 

Figure 2-9 

 

In TDOT, HQ Construction will load all Subcontracts into SiteManager and 
enter the approval date.  The field office will add the equipment and 
personnel to the subcontract’s DWR Master List for the Contract. 

 

Subcontract Descriptions 

The User enters the Subcontractor and DBE commitments on the Description 
folder tab. To be selected as a Subcontractor, a Contractor must first be entered 
as a vendor in the Vendor reference tables. When a new Subcontract is saved, the 
system adds the Subcontract amount to the total amount of uncompleted work for 
the Subcontractor. This value is displayed on the Vendors panel in Reference 
Tables (CA). The Contract’s Prime Contractor cannot be selected as a 
Subcontractor on the Contract. 

The percentage of the Subcontract that can be counted towards the Contract’s 
DBE goal depends on the Subcontract’s level, the Subcontractor’s DBE status, 
and whether or not the Subcontract includes Items. A Parent Subcontract with a 
DBE Subcontractor and Items is always counted 100% towards the Contract’s 
DBE goal. If the Subcontract has no Items (i.e., the Subcontractor is a 
supplier/hauler), the User enters the percentage counted towards the DBE goal. 
For nested Subcontracts, if a higher-level DBE Subcontract is counted 100% 
towards the DBE goal, the percentage of the nested Subcontract is always zero. 
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 Exercise 2-9 
In the following exercise, you will view a Subcontract description for Contract 
CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Contract Administration folder tab. 
2. On the Contract Administration panel, double-click the 

Contractor Management icon. 
3. On the Contractor Management panel, double-click the 

Subcontracts icon.  
4. How many subcontracts are there for Contract CNB022E?________ 
5. How many subcontracts are DBEs for Contract CNB022E? ______ 
6. In the Subcontract list box, scroll to and double-click Subcontract 

Number 01 APAC-MISSISSIPPI, INC. 
7. What is the approval date for this subcontract?    
8. What is the amount of this subcontract?     
9. Is this a nested subcontract?  ________________________________ 
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Viewing Subcontract Items 

The Subcontract Items folder tab lets the User add, modify, and delete 
Subcontract Items. If the Subcontractor is a hauler or supplier only, the 
Subcontract will not have Items. If the Subcontract has no Items, the User must 
enter the Subcontract Amount manually. If the Subcontract has Items, the 
Subcontract Amount is the sum of all of the Item amounts and the User cannot 
modify it. 

 

The Subcontracts Items Folder Tab 

Figure 2-10 

 Exercise 2-10 
In the following exercise, you will view a Subcontract item for Contract 
CNB022E.  

User ID: jj05757  Group: DCONREP Contract: CNB022E 

1. Click the Items folder tab. 
2. How many items are on this subcontract?     
3. What is the total quantity and dollar amount for Project Number 

55019-3220-94, Line Item 0110, Item Code 307-01.01, Short 
Description Asphalt Concrete Mix?_    
     __________________________ 

4. Click the Close button. 
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Review for Section 2 
To view a Contract’s description: 

1. On the Main Panel, double-click Contract 
Administration icon.  

2. On the Contract Administration panel, 
double-click the Contract Records icon.  

3. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

4. Click the Open button. The Select Contract 
list is displayed. 

5. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

To view a Contract’s location: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Location folder tab. 

To view a Contract’s payment data: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Payment Data folder tab. 

To view the Actual Date of a Contract Critical Date: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Critical Dates folder tab. 
5. In the Critical Date Description list box, 

scroll to and click the date. The data for the 
selected date is displayed below the list. 

To view Primary Personnel for a Contract: 

1. On the Contract Records panel, double-click 
the Contracts icon. The Contracts panel 
opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Primary Personnel folder tab. 

To view a Prime Contractor: 

1. On the Contract Records panel, double-click 
the Contracts icon. The Contracts panel 
opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Prime Contractor folder tab. 

To view the DBE goal for a Contract: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the DBE Commitments folder tab. 
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To view a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click OK. The panel displays data for the 
selected Subcontract. 

To view an Item on a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click OK. The panel displays data for the 
selected Subcontract. 

6. Click the Items folder tab. 
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Summary Exercise for Section 2 
In the following exercise, you will review Contract CNB022F.  

User ID: jj05757  Group: DCONREP Contract: CNB022F 

1. Navigate to the Contracts window. 

2. Open Contract ID CNB022F. 

3. What is the Work Type for this contract? _____________________________________ 

4. What Region and Unit is this Contract Assigned to? ____________________________ 

5. What is the Time Charge? _________________________________________________ 

6. What is the Execution Date of the contract? ___________________________________ 

7. What is the bonding company? _____________________________________________ 

8. Navigate to the Contractor Management folder tab. 

9. Open the Subcontracts window and open Subcontract 02 INTERNATIONAL TRAFFIC 
SYSTEMS, INC. on CNB022F.   

10. Is this subcontractor a DBE? _______________________________________________ 

11. Is this Subcontractor approved to begin working on this Contract? _________________ 

12. Is this subcontractor approved to install Line Item 0610, Item Code 730-50?  ________ 

13. Exit SiteManager. 
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Learning Module 

 Section 3  Estimate Basics & 
Approval 

for Management Personnel 
  

By the end of this module, you will be able to: 

• Understand the Basic Concepts of Daily Work Reports 

• View DWR 

• View Diary 

• View In-Box Estimate Message 

• View the Estimate Summary  

• View Estimate Discrepancies 

• Generate the Summary To Contractor Report 

• Approve Estimates 

• Track Estimates 

May 2007 
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Daily Work Reports I 

The User creates daily records of construction activity in Daily Work Reports.  
SiteManager lets the User create DWRs on the workstation in the field.  Before 
the Inspector can create the first DWR for a Contract in standalone mode, the 
Contract plan data must be downloaded from the SiteManager Server database to 
the User’s workstation.  After the User pipelines the Contract plan data onto the 
workstation’s local database, the User can begin creating DWRs in standalone.  
Typically, for each Contract, each User submits one DWR per day. Only the User 
who creates the DWR may modify it. 

The Daily Work Report Select panel lets the User open a DWR.  The panel lists 
all of the DWRs stored on the workstation for the selected Contract and the 
selected User ID.  The User can only access the DWRs stored in the local 
database in standalone mode.  The User can open any DWR in the database, but 
the User cannot modify a report the User did not create.  The DWR opens as 
Read Only if the system finds one of the following:  

• The Daily Work Report has been transferred to the server or standalone 
database  

• The Daily Work Report has been authorized 

• The Daily Work Report was authored by another User 

 

The DWR Info Folder Tab 

Figure 3-1 
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In TDOT, the Inspector will complete a DWR for every day during the life 
of a project, including weekends and holidays.   DWRs may also be created 
by Field Office personnel.  

A DWR may be created in Standalone Mode or Server Mode. 

In TDOT, field users are required to complete the DWR Date, 
Temperature, Weather Conditions, and appropriate Remarks (“Work 
Performed” at a minimum) on the project for the date of the DWR.  

For the Remarks type “Work Performed,” the field user should enter 
contractor’s name and details regarding item work progress. 

The Daily Work Reports window has the following folder tabs: 

DWR Info 

The DWR Info folder tab lets the User create a new DWR and collect 
information about the day for which the report was created. 

Contractors 

The Contractors folder tab lets the User enter daily data about the Prime and 
Subcontractor(s), Supervisor(s), and variable labor (by personnel type). 

Contractors Equip 

The Contractor Equip folder tab lets the User document the daily presence and 
use of equipment on the job site for a selected Contractor. 

Daily Staff 

The Daily Staff folder tab lets the User enter daily information on state 
employees and consultants.  Each entry shows how many hours the staff member 
worked, the type of work performed, and data on state vehicle usage. 

Work Items 

The Work Items folder tab lets the User view and add daily usage data for 
installed Work Items. 

Force Accounts 

TDOT will not use this feature. 
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 Exercise 3-1 
In the following exercise, you will log on as a Project Supervisor and view a Daily 
Work Report.   

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05753.  
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press Enter. 
6. On the Main Panel, double-click the Daily Work Reports icon. 
7. On the Daily Work Reports panel, double-click the Daily Work Reports icon.  
8. Click the Open button. 
9. In the Contract list box, scroll to and double-click Contract CNB022Q.   
10. In the Inspector list box, scroll to and double-click Inspector Warren, Jackie.   
11. In the Date list box, scroll to and double-click 04/28/05.   
12. Click the OK button in response to the message.   
13. Click the Contractors folder tab.   
14. Click the Contractor Equip. folder tab. 
15. Click the Daily Staff folder tab. 
16. Click the Work Items folder tab. 
17. In the Work Item list box, scroll to and double-click Line Item Number 0110, 

Category 0100, Project 55019-3220-94 ASPHALT CONCRETE MIX (PG64-
22) (BPMB-HM) GRADING A. 

18. Click the DWR Template button. 
19. Double-click Template ID SM39. 
20. Click the Close button to close the template. 
21. Click the Close button to close the DWR. 
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Diary Overview 

Each Diary is a daily collection of the authorized Daily Work Reports submitted 
by all personnel working on the Contract.  Only one Diary can be created per day 
per Contract.  Diaries can also be created for days when no Daily Work Reports 
are collected.  The Diary panel has two folder tabs:  

• Authorize (approving for payment) 

• Charge 

The User uses the Diary window to perform five functions: 

• Create a new or open an existing Diary for a specific contract 
and day 

• Preview Daily Work Reports for a specific contract and day 

• Authorize them (or not) for payment on the next estimate. 

• Apply Charges for a specific contract and day 

• Make Remarks 

The Authorize Folder Tab 
Figure 3-2 

 

In TDOT, the Lead Inspector or Project Supervisor will create a Diary for 
each day during the life of a contract, including weekends and holidays.  
The Lead Inspector or Project Supervisor will review and authorize all 
applicable DWRs associated with the Diary. 
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 Exercise 3-2 
In the following exercise, you will view the Diary window.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Daily Work Reports panel, double-click the Diary icon. 
2. Click the row for Inspector Warren, Jackie. 
3. Click the Preview DWR button. 
4. Click the Close button to close the preview. 
5. Click the Close button to close the Diary. 
6. Click the Main Panel folder tab. 
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SiteManager Estimates Overview 

The Estimate Generation process manages the Estimate functionality from the 
generation of an Estimate through the creation of the extract file for the 
transportation agency’s financial system. The functionality is divided into the 
following areas: 

• Generation of the Estimate 

• Review of Estimate Summary information 

• Resolution of Estimate discrepancies 

• Review of Estimate item details 

• Approval of the Estimate 

• Tracking of the Estimate status 

 

The Estimate Panel 

Figure 3-3 
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The Estimate generation process allows the user to generate an Estimate for the 
Contract. The user selects to generate a progress or a final Estimate from the 
Contractor Payments component. The system then performs a background 
process which performs the following activities: 

• Delete pending Estimate. This activity deletes any previous pending 
Estimate which has been calculated but not approved. The deletion will 
remove only details tied to the previous pending Estimate. 

• Determine quantities for payment. This activity will determine the 
quantity to be paid for each line item on the Contract which has items 
installed for the Estimate period. 

• Calculate stockpiled materials. This activity will determine if an 
installed item has stockpiled materials. If it does, the process will use a 
stockpiled materials conversion factor to add a new line item adjustment 
to adjust the amount of payment which is to be made for the line item. 

• Identify discrepancies. This activity checks for and reports 
'discrepancies' for the work being performed by defined rules and 
conditions, e.g., actual completion dates for milestones with projected 
completion dates during the Estimate period. This activity provides a 
window with discrepancy details for the Project Supervisor so that 
proactive steps can be taken for various project issues.  

• Determine Funding Amounts. This activity will calculate the funding 
amount for the different funding sources based upon the funding given 
for the Contract, project, category or item. 

 
TDOT Estimate Generation Schedule 

In TDOT, all Progress Estimates are generated by the Office Staff of the Unit 
assigned the contract.  Before the Estimate Generation and Reconciliation Cycle 
can begin, the Inspection staff must pipeline all DWRs through the DWR Ending 
Date for their region to the server.  The following table outlines the Estimate 
Generation schedule for each of the Regions. 

 
Region 

 
First DWR Date 

Ending DWR Date (Estimate 
End Date) 

First Day Office Staff Can 
Generate Estimate 

Region 1 21st day of the previous 
month 

Through 20th day of the 
current month 

21st day of the current 
month 

Region 2 1st day of the previous month Through the last day of the 
previous month 

1st day of the current month 

Region 3 1st day of the previous month Through the last day of the 
previous month 

1st day of the current month 

Region 4 16th day of the previous 
month 

Through the 15th day of the 
current month 

16th day of the current 
month 

The TDOT Progress Estimate Generation Schedule 

Table 3-1 
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Viewing an In-Box Estimate Approval Request Message 

As part of the estimate approval process, when an estimate is created and 
approved at a lower approval level, SiteManager generates a system message 
notifying the next user in the approval process that an estimate is ready for 
review and approval.  This message appears in the user’s In-box. 

 
The In-Box Window 

Figure 3-4 

 Exercise 3-3 
In the following exercise, you will view a message on the In-box window for contract 
CNB022Q, Estimate 0001.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Main Panel, double-click the Accessories icon. 
2. On the Accessories panel, double-click the In-Box icon. 
3. Double-click the message titled Estimate Number 0001 for CNB022Q 

Awaiting Approval. The Estimate Approval window opens. 
4. In the Contract list box, double-click Contract CNB022Q. 
5. Click the Close button to close the window with out approving the estimate. 
6. Click the No button. 
7. Click the Close button. 
8. Click the Main Panel folder tab. 
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Viewing the Estimate Summary 

The Estimate Summary window allows the User to view calculated Estimate 
summary information. It may be accessed from the Estimate panel or from the In-
Box. The window shows three sets of totals:  

• Previous Estimate(s) - Combined totals for previous Estimate(s) 

• This Estimate – totals for the current Estimate 

• Totals to date – combined totals for all Estimates 

 

The Estimate Summary Window 

Figure 3-5 
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 Exercise 3-4 
In the following exercise, you will view the Estimate Summary window for contract 
CNB022Q.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Estimate icon. 
3. On the Estimates panel, double-click the Estimate Summary icon. 
4. Double-click Estimate number 0001. 
5. What is the amount paid to the contractor on this estimate? 

______________________ 
6. Are there discrepancies on this estimate? ______________________ 
7. Click the Close button. 
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Viewing Estimate Discrepancies 

SiteManager identifies the discrepancies associated with an Estimate and 
displays them in the Estimate Discrepancy window. The discrepancies are of two 
levels: discrepancies at the Estimate level and discrepancies at the item level. For 
instance, if a Checklist Event Date is not met, the discrepancy is associated to the 
Estimate. If an item overrun is displayed, the discrepancy is associated with the 
specific line item.  

Estimate discrepancies are listed at the top of the Estimate Discrepancy window, 
and the item discrepancies are listed after them. The Status field values are either 
‘Unresolved’ or ‘Override.’ When the Recalculate Discrepancies function is 
selected from the Services menu, or if the Estimate is regenerated, the 
discrepancies are re-determined. 

 

The Estimate Discrepancy Window 

Figure 3-6 

 

The Navigate Button 

Figure 3-7 
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TDOT Discrepancy Types 

There are four types of discrepancies utilized at TDOT. Each are identified using 
different criteria.  

Overrun Discrepancy – Occurs if a major item is overrun by 5 percent or more 
and a minor item overrun by 10% or more. 

Milestone Completion Date Missed Discrepancy – Occurs if a milestone has 
not been completed within the time frame specified on the Milestones window. 

Contract Completion Date Missed Discrepancy – Occurs if work is recorded 
on a DWR beyond the Contract Completion Date specified on the Contracts 
window/Critical Dates folder tab. 

Checklist Event Completion Date Missed Discrepancy – Occurs if the Actual 
Date of the Checklist Event has not been entered on the Checklist Event Dates 
window within the time frame specified on the Checklist Scheduled Events 
window. 

In TDOT, if an estimate discrepancy on a Progress Estimate cannot be 
resolved, the discrepancy must be overridden with an explanation. 
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 Exercise 3-5 
In the following exercise, you will review an Estimate Discrepancy on Estimate 0001 
for contract CNB022Q.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Estimate panel, double-click the Estimate Discrepancy icon. 
2. Click the discrepancy that says Major Item 55019-3220-94/0120 exceeds 

Overrun Limits. 
3. Click the Remarks button. 
4. What is the reason for this Override? 

________________________________________________________________ 
5. Click the Remarks button. 
6. Click the discrepancy that says Major Item 55019-3220-94/0110 exceeds 

Overrun Limits. 
7. Click the Remarks button. 
8. What is the reason for this Override? 

________________________________________________________________ 
9. Click the Remarks button. 
10. Click the Navigate button.   
11. Click Yes to the message. The Estimate Item Detail window displays the bid 

amount for each item on the estimate, as well as the amount paid for on this 
estimate.  Review line items 0110 and 0120. 

12. Click the Close button. 
13. Click the Close button. 
14. Click the Contractor Payments folder.  
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Generating the Summary to Contractor Report 

The Summary to Contractor report displays the amounts to be paid to the 
Contractor based on the estimate.  The report summarizes previous payments 
made to the Contractor and the current status of the Contract when the estimate is 
generated. An itemized description of quantities and amounts on all items in 
every project contained in the estimate is also given. 

The report consists of two pages. The first page summarizes the Contract 
information.  The second page lists the quantities and amounts of all the items for 
each project in the Contract. 

 
 

The Estimate Summary to Contractor Report 
Figure 3-8 

 

In TDOT, staff will review the Summary to Contractor report to ensure 
that the line item payment is correct.  If changes are required, the Office 
Staff will follow the Estimate Correction Procedure.  

The Summary to Contractor Report should be printed in Landscape with 
the smallest font size. Refer to the Review in this section for steps to modify 
the font and print preference. 
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 Exercise 3-6 
In the following exercise, you will generate the Summary to Contractor Report for 
Estimate 0002 for contract CNB022Q.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Contractor Payments panel, double-click the Process List icon. 
2. In the Process List, click the Summary to Contractor.  
3. Click the Run Process button. 
STOP. Do not submit the process in SiteManager Training.  
4. Click the Cancel Button 
5. Click the Close Button. 
A copy of the report is saved at C:\SMTRAINS\SMFILES to view during training.  
6. Right-click the Start button at the bottom left of the screen. 
7. Click the Explore choice. 
8. Navigate to the C:\SMTRAINS\SMFILES folder. 
9. Double-click Estimate Summary to Contractor CNB022P.htm. 
10. After viewing report, click the Close button to close the browser window. 
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Approving Estimates 

The Estimate Approval window allows the authorized reviewers to approve all 
Estimate types—progress or final. The approval process provides an audit trail 
and prepares the Estimate for the creation of the extract file that can be used by the 
Tennessee Department of Transportation’s financial system. The approval process 
is conducted by a chain of approvals established during SiteManager installation or 
at Contract setup. Each approval level corresponds to a User group within 
SiteManager.  

The Estimate is approved starting with the first level (Office Staff) and is 
completed with the last reviewer who indicates that the Estimate is ready for 
payment. A User that belongs to an approval group can approve any level lower 
than their own approval level except for the first approval level. Once the last 
approval level has approved the Estimate, a generic file layout is created which 
contains all payment information required by the Tennessee Department of 
Transportation’s financial system and available in SiteManager. 

 

The Estimate Approval Window 

Figure 3-9 
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TDOT Progress Estimate Review and Approve Workflow 

The Office staff will complete the following tasks as part of the estimate 
generation and review process: 

Estimate DWR Correction Workflow Tasks Functional Navigation 

1. Office Staff will delete the pending estimate if a 
correction must be made to a DWR/Diary for the 
estimate period.  If an adjustment has been made to 
the estimate, the adjustment plug-in must be used 
to place the estimate back in pending status prior to 
deleting the estimate. 

Contractor Payments 
> Estimate > 
Estimate History 

2. Office Staff / Lead Inspector will unauthorize the 
DWR(s) that need to be corrected.  Note: DWRs 
created by Office Staff should be unauthorized by 
the Office Staff; DWRs created by Inspection staff 
should be unauthorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

3. DWR Creator (Inspectors only) will pipeline the 
DWR to standalone mode to correct the DWR. 
Note: Office Staff DWRs are created and corrected 
in Server mode.  Inspection staff DWRs are created 
and corrected in Standalone mode 

Pipeline > Server to 
PM 

4. DWR Creator corrects the DWR.   Daily Work Reports 
> DWR 

5. DWR Creator (Inspectors only) will pipeline the 
DWR to server mode after correcting the DWR 

Pipeline > PM to 
Server  

6. Office Staff / Lead Inspector will authorize the 
corrected DWR.  Note: DWRs corrected by Office 
Staff should be authorized by the Office Staff; 
DWRs corrected by Inspection staff should be 
authorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

7. Office Staff will generate the Estimate and repeat 
Progress Estimate Generation workflow. 

Contractor Payments 
> Estimates > 
Generate Estimate 

The TDOT Progress Estimate Review Process 

Table 3-2 
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In TDOT, progress estimates are approved by: 

• Office Staff 

• Project Supervisor 

• Finance Staff 

In TDOT, the final estimate and supplemental estimate are approved by 
the following personnel: 

• Office Staff 

• Project Supervisor 

• Regional Director Rep 

• Finance Staff 

• Director of Construction 

 

 Exercise 3-7 
In the following exercise, you will approve Estimate 0001 for contract CNB022Q.  

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Contractor Payments panel, double-click Estimate icon.  
2. On the Estimate panel, double-click the Estimate Approval icon. SiteManager 

displays the Select Contract/Estimate list box. 
3. In the Contract list box, scroll to and double-click the Contract CNB022Q. 
4. Click the Approved check box (ON) for your level. 
5. Click the Save button.  
6. Click the Close button. 
7. In the message, click the OK button. 
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Tracking Estimates 

The Estimate Tracking window is a view-only window that allows the tracking of 
Estimate generation, approval, and rejection.  A User can access the window to 
determine where the Estimate is in the approval process. 

 

The Estimate Tracking Window 

Figure 3-10 

In TDOT, users may access this window to view the status of Estimates on 
the Contract. 

 Exercise 3-8 
In the following exercise, you will track an Estimate. 

User ID: jj05753 Group: PJSUPS Contract: CNB022Q 

1. On the Estimate panel, double-click the Estimate Tracking icon.  
2. What date was the estimate generated? ______________________ 
3. Who generated the estimate? ______________________________ 
4. Click the Close button.  
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Review for Section 3 
To access the Daily Work Report window: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

3. Click the Open button. 

4. In the Contract ID list box, scroll to and 
double-click desired Contract. 

5. On the Inspector list box, scroll to and 
double-click the desired User ID.   

6. On the Date list box, scroll to and double-
click desired DWR Date. 

7. Click OK. 

8. Click the Contractors folder tab.  

9. Select the desire Contractor to display 
Supervisors and Personnel Types. 

10. Click the Contractors Equip. folder tab. 

11. Select the desired Contractor to display 
Equipment. 

12. Click the Work Items folder tab. 

13. On the Work Items list box, scroll to and 
click the desired Work Item.  

14. Click the Record Work Items button. 

15. Click the Select Work Items button and 
repeat steps 11 and 12 until review of work 
items is complete.  

16. Click the Close button.  

To view Work Item Data in DWR Templates: 

1. On the SiteManager Main Panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, 
double-click the Daily Work Reports 
icon. 

3. Click the Open button. 

4. In the Contract ID list box, scroll to and 
double-click desired Contract. 

5. On the Inspector list box, scroll to and 
double-click the desired User ID.   

6. On the Date list box, scroll to and double-
click desired DWR Date. 

7. Click OK. 

8. Click the Work Items folder tab. 

9. On the Work Items list box, scroll to and 
click the desired Work Item.  

10. Click the Record Work Items button. 

11. To invoke the DWR Template window 
click on the DWR Template button.  

12. The DWR Template ID window displays 
the Templates available for use with the 
selected Work Item. Choose a DWR 
Template to record data to and click the 
Record Template Data button. 

13. Click the Close button to return to the 
Record Work Item window. The Placed 
Qty field is now populated with the value 
from the DWR Template and the Templt 
Used box is checked. 
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To view a Diary: 

1. On the Daily Work Reports panel, 
double-click the Diary icon. The Diary 
Authorize folder tab opens. 

2. Click the Open button. 

3. In the Contract list box, scroll to and 
double-click the desired Contract. 

4. In the Diary list box, scroll to and click the 
DWR Date of the Diary. (The DWR Date 
represents both the Daily Work Report 
Date and the Diary Date.) 

5. Click OK.  The Diary Authorize folder tab 
displays the Daily Work Reports submitted 
for this date.   

To preview a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon. The Diary Authorize 
folder tab opens.   

2. Click the Open button. 

3. In the Contract list box, scroll to and 
double-click the desired Contract. 

4. In the Diary list box, scroll to and click the 
DWR Date of the Diary. (The DWR Date 
represents both the Daily Work Report Date 
and the Diary Date.) 

5. Click OK.  The Diary Authorize folder tab 
displays the Daily Work Reports submitted 
for this date.   

6. In the Inspector list box, scroll to and click 
the Inspector who submitted the Daily Work 
Report to be previewed. 

7. Click the Preview DWR button.  A 
summary report of the selected Daily Work 
Report is displayed in a print preview 
window.  The user can either review the 
information on-line or print it.   

8. To close the print preview window, click the 
Close button. 

To open the In-Box: 

1. On the Main Panel, double-click the 
Accessories icon. 

2. On the Accessories panel, double-click the 
In-Box icon. 

To open a mail message: 

1. Double-click the message. 

2. When finished, click the Close button. 

To open an Estimate summary: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

2. Double-click the Estimate Summary 
icon. 

3. Click the Open button. 

4. In the Contract list box, scroll to and 
click the desired Contract. 

5. Click Ok.  

6. When through, click the Close button. 

To open an Estimate discrepancy: 

1. On the Estimate panel, double-click the 
Estimate Discrepancy icon. 

2. In the list box, scroll to and double-click 
the desired Contract. 

3. In the list box, scroll to and click the 
desired Estimate. 

4. Click Ok. 
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To generate the Summary to Contractor Report: 

1. On the Contractor Payments panel, 
double-click the Process List icon. 

2. In the Process List, click the Summary to 
Contractor. 

3. Click the Run Process button. 

4. Double-click the desired contract ID.  

5. Double-click the desired estimate number.  

6. Click the Submit button. 

7. Click the OK button. 

8. Click the OK button. 

9. Click the Services menu.  

10. Double-click the desired process name.  

11. Double-click Output.html. 

12. Click the Page button.  

13. Click Text Size, and then click Smallest. 

14. Click the Page Setup button.  

15. Click the Landscape radio button.  

16. Click the Ok button.  

17. Once the report displays, close the 
browser window. 

18. Click the Close button. 

To approve an Estimate: 

1. On the Estimate panel, double-click the 
Estimate Approval icon. 

2. In the Contract list box, scroll to and 
double-click the desired Contract. 

3. In the Estimate list box, scroll to and 
click the desired Estimate. 

4. Click OK.  

5. Click the Approved check box (ON) for 
your level. 

6. Click OK.  

7. Click the Save button. 
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Summary Exercise for Section 3 
In the following exercise, you will perform the Estimate process activities for 
contract CNB022R.   

User ID: jj05753 Group: PJSUPS Contract: CNB022R 

1. Navigate to the Estimate Summary window for CNB022R, Estimate 0003. 

2. What are the Item Earnings for Estimate Nbr. 0003? _________________________________ 

3. Are there discrepancies on Estimate Nbr. 0003?_____________________________________ 

4. Navigate to the Estimate Discrepancy window, and review the discrepancies associated with 
the estimate.  

5. What are the two purposes of the Summary to Contractor Report? 

___________________________________________________________________________ 

6. Review the Tracking window for Contract CNB022R, Estimate Nbr 0003.   

7. Who is the next approver for this estimate?        

8. Exit SiteManager. 
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Learning Module 

 

 

 

 

 Section 4  Change Order Basics 
for Management Personnel 

 

By the end of this module, you will be able to: 

• Understand the Rules and Life Cycle of Change Orders 

• View a Change Order Header 

• View Change Order Time Adjustments  

• View Modifications to Contract Items  

• View the Custom Change Order  

• View the Change Order Report 

• Approve Change Orders 

• Track Change Orders 

 

May 2007 
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Change Order General Concepts 

The change order process allows legal changes to be made to a Contract by 
creating, approving, and tracking changes.   

Contract Change Orders may include: 

• Quantity adjustments for existing items (overrun/underruns) 

• Adding new items of work to the contract (extra work) 

• Time Extensions on milestones or revisions to Contract time or 
Contract completion date 

• Additions to the Contract not affecting time or item quantities 

Except for zero dollar change orders, users can specify more than one function to 
make up a change order.  Before a change order is saved, edits are performed to 
ensure that its components are reconciled with its selected functions.  Messages 
advise the User if information has not been entered for a selected function. 

Before the User can select a specific window in the Change Order (CO) function, 
a specific Contract must be selected from a pick list containing valid Contracts, 
and associated, existing COs.  A specific Contract must be selected from the pick 
list to create a new change order. 
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The Change Order Maintenance Panel  

Figure 4-1 

 Exercise 4-1 
In the following exercise, you will first navigate to the In-box to view a Change 
Order message and then navigate to the Change Order Maintenance Panel.   

User ID: jj05756 Group: RDIR  Contract: CNB022I 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. In the User ID field, type jj05756. 
3. In the Password field, type pass. 
4. Click the Logon button. 
5. On the Main Panel, double-click the Accessories icon. 
6. On the Accessories panel, double-click the In-box icon. 
7. Double-click on the message from 08/01/06 21:00:03 where the 

subject is “Change Order Approval Cycle”. 
8. Click the Close button. 
9. Click the Close button. 
10. Click the Main Panel folder tab. 
11. On the Main Panel, double-click the Change Orders icon. 
12. On the Change Orders panel, double-click the Change Order 

Maintenance icon. 
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Change Order Life Cycle 

The life cycle of contract change orders is reflected in the change order functions 
in SiteManager. 

1. Creating a New Change Order  

A CO can only be created by a User with specific authority to create new change 
orders.  A change order must be associated with an existing active Contract.  
Specific information about the change order must be recorded using the Change 
Order Header window, the Change Order Items window, the Time Adjustments 
window, and/or the Change Order Explanations window. 

2. Maintaining Change Orders 

Once a CO has been created, updates to the CO information may be required.  
Change Order header information, items, time frames, and explanations may be 
modified in update mode on the appropriate windows. 

3. Reviewing and Approving Change Orders 

After it is created, a draft CO can be forwarded via In-box notification for 
parallel review.  Parallel review is concurrent review by more than one reviewer 
at a time.   

The writer of the CO can also place the change order into Pending status and 
submit it for a hierarchical approval, skipping the review process.  

Users involved in reviewing a draft CO or approving a pending CO can record 
their decisions about proposed changes to the Contract on-line, using the 
Review/Approve window.  Reviewers/Approvers receive an In-Box message 
from the author requesting an action, review or approval for the CO.  The In-Box 
message specifies the Contract and change order number. 

When a Change Order that is in Pending status (in the approval process) is given 
the recommendation “Denied” in the Change Order Review/Approve window, it 
remains in Pending status.  The creator of the Change Order may choose to 
change the status of the Change Order to Draft in order to make modifications to 
the Change Order, then change it back to Pending to resubmit it for approval.  If 
the Change Order will never be approved, it may be changed to Denied status in 
the Header window.  Once a Change Order is in Denied Status, it may not be 
modified or submitted for review/approval. 

All change orders on a contract must be either Approved or Denied in order for 
the Physical Work Complete Date to be entered by Headquarters Finance, as part 
of the Contract completion process.  (Change Orders may not be in a Draft or 
Pending status for the Contract completion process.)   
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4. Tracking the Change Order 

At any time, the writer of the CO may view the status of a change order in the 
review or approval cycle by opening the Tracking window.  The Tracking 
window for a CO is a view-only window and displays: 

• The date a request for recommendation was sent to a reviewer or 
approver 

• The reviewer or approver’s name 

• The action requested - review or approve  

• The date the reviewer or approver makes a recommendation 

• The recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also display details about current and historic Contract 
items on-line using the Item Summary window. 

5. Reports 

Once approved, change order data may be analyzed to help manage the change 
order process.  The Change Order Reports function allows users to produce 
reports that gather information about trends in Contract changes.   

In TDOT, a paper copy of the change order is still required for physical 
signatures.  SiteManager reflects electronic version. 

When an approver physically signs the Change Order, that approver 
should also indicate their approval of the Change Order in SiteManager. 
The Headquarters Finance Office will indicate approval of the Change 
Order on behalf of all applicable Headquarters approvers.  

 



Trns•port SiteManager® Learning Guide Change Order Conditions 
Section 4  Change Order Basics SiteManager for Management Personnel 

 

 

106  

Change Order Conditions 

There are three conditions that affect how the Change Order process in 
SiteManager works.  These are the: 

• Type of Contract 
• Function(s) associated with the change order 
• Status of the change order 

Change Order Functions 

There are six types of change orders: 

• Overrun/Underrun 
• Extra Work 
• Time Adjustment 
• Zero Dollar 
• Force Account – TDOT will not use this function.  Force Account COs 

are “Extra Work” in TDOT. 
• Final Quantity – TDOT will not use this function. Final Quantity COs 

are “Overrun/Underrun” in TDOT.  

A change order may be a combination of types except for a Final Quantity CO, a 
singular change order required for contract completion, or a Zero Dollar. 

Users define the purpose of the change order by selecting among the different 
functions.  Except for Final Quantity and Zero Dollar, users can specify more 
than one function to make up a change order.  The functions available on a 
change order are: 

Overruns or Underruns:  Used when the quantities associated with the Contract 
items are either exceeded or not needed to complete the Contract or work item. 
Extra Work:  Used when additional work items are required to complete the 
Contract. 
Time Adjustments:  Used when the time frames need to be adjusted to reflect 
the completion period for a milestone or Contract. 
Zero Dollar:  Used only for contract adjustments that will not affect the dollar 
amount of the Contract (for example, adding permits or special provision to the 
contract). 
Force Account:  TDOT will not use this function. Force Account COs will 
require the “Extra Work” function to be selected. 
Final Quantity:  TDOT will not use this function. Final Quantity COs will 
require the “Overrun/Underrun” function to be selected. 
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Change Order Status  

The CO Status field displays the current status of the change order in the creation, 
review, and approval process.  The change order Status types are: 

Draft:  A change order is Draft status while it is being created, edited, or 
forwarded for review. 

Pending:  A change order is changed to Pending status when it needs to be 
submitted for the approval process.  While in Pending status, the change order 
cannot be modified except for its status. 

Denied:  A change order is changed to Denied status manually by the creator after 
the change order is denied by an approver in the approval process.  The Denied 
status is not available until an approver has selected “denied” in the Changer Order 
Review/Approve window. When an approver selects “denied,” the change order 
remains in Pending status for a user to take action to either change it back to Draft 
and make modifications to it, or to change the status to Denied causing it to become 
inquiry-only for the life of the contract.  The user must change the status back to 
Draft or to Denied manually after the Change Order is denied or it will remain 
Pending. 

A Denied change order in Pending status may have its status changed to back to 
Draft, be edited (revised), have its status changed to Pending, and be resent through 
the approval process. 

Approved:  A change order is automatically placed in Approved status when the 
last approver completes the approval process – it is not a manual selection. When a 
change order has been approved by its final approval level, it cannot be altered.  
Adjustments can only be made by creating a new change order.   

All change orders must be in either Approved or Denied status for the contract 
completion process. 

In TDOT, if an approver selects “deny” in the review/approve window, the 
creator should change the status back to draft, make corrections, and change it to 
Pending in the Header window to submit again. 

If an approver selects “denied” in the review/approve window and provides a 
remark indicating that the Change Order will never be approved and provides a 
reason, the creator should change the status of the Change Order to Denied in the 
Header window. 

BEWARE:  A Change Order in Denied Status may not be changed to Draft. 
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The TDOT Change Order Process  

In TDOT, all change orders will typically be created and maintained by the Office 
Staff.  There are three phases in the TDOT CO Process. They are as follows: 

Creation of a Change Order 
• Prepare any applicable paperwork  

• Create the change order on the Change Order Header window in SiteManager 

• Add item adjustments and/or new items to the change order on the Change 
Order Items window in SiteManager 

• Add time adjustments to the change order on the Change Order Time 
Adjustments window in SiteManager. 

• Add explanations to the change order on the Change Order Explanations 
window 

Maintaining & Reviewing a Change Order 
• Forward the change order for parallel review  

• Track the change order 

• Revise the change order as necessary 

• Generate applicable change order reports 

Change Order Approval Process 
• Change status to Pending 

• Forward the change order for approval 

• Track the change order 

• Change the Status to Draft to revise the change order as necessary 

• Generate applicable change order reports 

• Change the Status to Denied if an approver selects Denied on the Change 
Order review/approve window, provides a remark indicating that the Change 
Order will never be approved, and provides a reason for the never approving 
it. 
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Viewing a Change Order Header 
The Change Order Header window allows an authorized User to: 

• Create a new change order by entering a new descriptive information for 
a change order, or  

• Maintain the current descriptive information about an existing change 
order as the status of the change order progresses from Draft through 
Pending to Approved or Denied.   

The CO Type field has TDOT-defined change order types of: 

• Category 1 

• Category 2 

• Category 3 

• Final Estimate 

• Time Adjustments due to quantity increase 
 

As per Policy Number 355-01, change order categories are defined as follows: 
Major Change - Category 1 

A major change is defined as: 
• Any cumulative change to the working time/completion date of the contract in 

excess of 7.5% of the original contract time; 
• Or any change/addition that alters the total original contract amount by more than 

$250,000. 
Intermediate Change - Category 2 

An intermediate change is defined as: 
• Any cumulative change to the working time/completion date of the contract not in 

excess of 7.5% of the original contract time; 
• Any change/addition that alters the total original contract amount by more than 

$150,000 but less than or equal to $250,000; 
• Any change/addition that alters the total original contract amount by more than 

ten percent (10%)of the original contract; 
• Any change to a unit bid price: 
• Or any change to a special provision or contract provision. 

Minor Change - Category 3 
A minor change is defined as any changes/additions other than those specified under 
Major Change or Intermediate Change as shown above. 

In TDOT, the Reason Code and CO Type fields are used to control the custom Change 
Order Report and Force Account Approval Form.  All entries listed in the Reason Code 
picklist can be selected for Change Orders except for “Force Account.”  This should only 
be selected when adding a Force Account item to the contract and must be selected in 
order to generate the Force Account Approval Form.   

The appropriate Change Order Category (1, 2 or 3) must be selected in the CO Type field 
in order for the appropriate signatures to appear on the Change Order and Force Account 
Approval Form.  The CO Type’s “Final Estimate” and “Time Adjustment Due to Quantity 
Increase” are used for special contract finalization processing and neither requires a 
signed Change Order (See Contract Finalization Section for details). 
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The Change Order Header Window  

Figure 4-2 

 Exercise 4-2 
In the following exercise, you will view Change Order 001 for Contract CNB022I.  

User ID: jj05756 Group: RDIR  Contract: CNB022I 

 
1. On the Change Order Maintenance panel, double-click the Header icon.   
2. In the Contract ID list box, scroll to and double-click Contract CNB022I.   
3. In the Change Order list box, scroll to and double-click Change Order 001. 
4. What is the description of this change order? 

 __________________________________________________________ 
5. What is the dollar amount for this change order?   ______ 
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Viewing Change Order Time Adjustments 

The Time Adjustments window allows authorized Users to enter one or more 
time adjustments for a change order.  At least one adjustment must be recorded 
using this window if the Time Adjustment function is selected on the change 
order.  Time adjustments may be related to: 

• The Contract completion date 
• Milestone(s) on the Contract, or  
• Both the Contract completion date and milestone(s) associated with the 

Contract  

The Charge Type for the Contract or Milestone determines which timing 
components of the Contract and its associated milestones may be entered and 
modified.  The three types of Time Charges are: 

Completion Date Charge Type:  Has a specific fixed end date for the Contract or 
for milestones within the Contract.  Only the completion date field may be 
entered.  The system computes the number of days adjusted. 

Available Days Charge Type:  Only the number of days adjusted may be entered 
in the Time Adjustment Window.   

Calendar Days Charge Type:  Computes the end date for the Contract and for 
milestones based on the number of calendar days allocated for the work.  The 
number of days adjusted may be entered.  The system then computes the 
completion date. 

TDOT will primarily use Completion Date contracts and milestones.   

The Time Adjustments window has limits as follows: 

• Only one adjustment to the Contract completion date may be entered per 
change order. 

• Only one adjustment to each Milestone completion date or number of 
days may be entered per change order. (Time Adjustment Change Orders 
for Milestones are only needed to accommodate changes to SP108B, 
such as phased construction and mowing and litter cycles, because they 
are contractual milestones.  These would be Category 2 COs - 
modifications to Special Provisions.) 

• Text explaining reasons for the time adjustment may be entered. 
• The status of the associated change order determines whether the fields 

on this window are display only or may be modified by the user.  Time 
adjustments may only be entered while a change order is in Draft status.  
Changes orders in a Pending, Approved, or Denied status do not allow 
updates to these fields. 
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The Change Order Time Adjustments Window  

Figure 4-3 

 

In TDOT, the Explanation in the Change Order Time Adjustments window 
should always be “See Change Order Explanations.” 

 

 Exercise 4-3 
In the following exercise, you will navigate to the CO Time Adjustment window 
from the Header window and view a time adjustment on Change Order 001 for 
Contract CNB022I.  

User ID: jj05756 Group: RDIR  Contract: CNB022I 
1. On the Header window, click the Services menu and click CO Time 

Adjustments. 
2. How many days were added to the contract completion date?    
3. What is the new contract completion date?      
4. Click the Close button on the toolbar.  
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Viewing Modifications to Contract Items 

The Change Order Items window allows the User to: 

• Select an existing item on the Contract for inclusion in the change order 

• Add a new item to the Contract by including it in the change order 

• Select and modify an existing item in the Contract already associated 
with the change order 

• Delete an item from a change order 

Whenever the change order function is an overrun/underrun and/or extra work, 
the Change Order Items window must be used to make the corresponding entries 
and/or modifications to the change order items.  Extra work requires adding 
completely NEW Contract Item(s). Overrun/underrun requires modifying 
existing contract pay items. 

When modifying an existing Contract Item, select the Services menu “New CO 
Item” choice to bring up a list of existing contract items from which to select.  
The Quantity field may then be used to modify the item quantity.  

When adding a new item to the Contract, select the “New Contract Item” folder 
tab to define the item.  Then select the Change Order Item folder tab to define the 
item quantity in the Quantity field. 

 

The Change Order Item Folder Tab 

Figure 4-4 
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 Exercise 4-4 
In the following exercise, you will view adjustments for two contract items for 
Change Order 002 for Contract CNB022I.  

User ID: jj05756 Group: RDIR  Contract: CNB022I 
1. On the Header window, click the Open button. 
2. In the Change Order list box, double-click 002. 
3. Click the Services menu and click CO Items. 
4. In the Change Order Items list box, double-click Item Nbr 0100. 
5. What is the adjustment to the item quantity for this change order? _______ 
6. Has this item been adjusted on any other change orders for this contract? ____ 
7. Click the Open button. 
8. Click the Change Order Items selection button. 
9. In the Change Order Items list box, double-click Item Nbr 9500.   
10. What is the adjustment to the item quantity for this change order? _______ 
11. Click the Close button. 
12. Click the Close button. 
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Viewing the Custom Change Order  
The Custom Change Order is a custom TDOT document.  

 
The Change Order Parameters Window  

Figure 4-5 

 
The Change Order Window  

Figure 4-6 
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In TDOT, the custom Change Order will be used to gather signatures on a 
Change Order. 

When an approver physically signs the Change Order, that approver should 
also indicate their approval of the Change Order in SiteManager. The 
Headquarters Finance Office will indicate approval of the Change Order on 
behalf of all applicable Headquarters approvers. 
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Viewing the Change Order Report 

The Change Order Report window can be utilized as a source of information for 
the review and/or approver of a change order.  This is a two-page report window 
that displays all other data included on a change order.  The second page displays 
only if there are Time Extensions associated with the change order selected for 
this report. 

 

The Change Order Report 

Figure 4-7 

 

The standard Change Order Report is available in Standalone mode. 
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 Exercise 4-5 

In the following exercise, you will access and view the Change Order Report for 
Change Order 002 for Contract CNB022I.   

User ID: jj05756 Group: RDIR   Contract: CNB022I 
1. Click the Change Orders folder tab. 
2. On the Change Orders panel, double-click the Reports icon. 
3. Double-click the Change Order Report icon. 
4. Using the right mouse button, click the Change Order field. 
5. In the Object menu, click Search. 
6. In the Search window, scroll to and click 002. 
7. Click Ok to generate the report. 
8. What is the description for this change order? 

______________________________________________________________ 
9. What is the Total Value of Change Order 003?     
10. Click the Close button. 
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Reviewing and Approving Change Orders 

The Change Order Review/Approve icon allows the user who receives an In-Box 
message to review a draft change order or to approve a pending change order. 

The Review/Approve window allows the user to: 

• Access the change order information 

• View the contract and change order information on-line 

• Document their recommendation to approve or deny the Draft or Pending 
Change Order 

• Record Remarks related to their recommendation. Remarks are optional. 

 
The Change Order Approval Window  

Figure 4-8 

 

In TDOT, when a change order is denied by a user in the approval process, 
that user must indicate the reason for the denial in the Remarks field.  

When an approver physically signs the custom Change Order document, that 
approver should also indicate their approval of the Change Order in 
SiteManager. 

The Regional Secretary will enter the electronic signature for the Contractor 
when the physical signature is received. 

Electronic approvals are not entered in SiteManager for the following groups 
who are responsible for physically signing the Custom Change Order Report: 

 Director of Construction 

 Assistant Chief Engineer of Operations 

 Commissioner 

 FHWA – unless Federal Oversight contract 
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 Exercise 4-6 
In the following exercise, you will approve Change Order 002 for Contract 
CNB022I.   

User ID: jj05756 Group: RDIR  Contract: CNB022I 
1. Click the Change Order folder tab. 
2. On the Change Order panel, double-click the Change Order Maintenance 

icon. 
3. On the Change Order Maintenance panel, double-click the Change Order 

Review / Approve icon. 
4. In the Contract ID list box, double-click contract CNB022I. 
5. In the Change Orders list box, double-click CO Nbr 002. 
6. On the Change Order Approval window, click the Approved radio button. 
7. Click the Save button. 
8. On the Please Confirm Recommendation message box, click the Yes button. 
9. Click the Ok button. 
10. Click the Close button. 
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Tracking Change Orders 

The status of a Change Order in the review or approval cycle can be monitored 
by opening the Tracking window at any time. The Tracking window for a CO is 
a view-only window and displays the following information: 

• The date a request for recommendation was sent to a reviewer or approver 

• The reviewer or approver’s name 

• The action requested - review or approve 

• The date the reviewer or approver made a recommendation 

• Τhe recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also view details about current and historic contract items 
on-line using the Item Summary window. 

 

The Change Order Tracking Window  

Figure 4-9 
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 Exercise 4-7 
In the following exercise, you will view the tracking window for Change Order 002 
for Contract CNB022I.   

User ID: jj05756 Group: RDIR  Contract: CNB022I 
1. On the Change Order Maintenance panel, double-click the Tracking icon. 
2. Click the CO Tracking List folder tab. 
3. Who is the next person to approve the change order?     
4. Click the Close button. 
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Review for Section 4 

To access the Change Order Header window: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Header icon. 

4. In the Contract list box, scroll to and 
double-click the desired contract. 

5. In the Change Order list box, scroll to and 
click the desired change order. 

6. Click Ok.   

To navigate to other CO functions from the Header 
Window: 

1. Create a New Change Order Header or open 
an existing Change Order Header. 

2. Click the Services menu and click the CO 
Items, CO Time Adjustments, or Change 
Order Tracking choice. 

To view an existing time adjustment for a contract or 
milestone: 

1. On the Change Order Maintenance panel, 
double-click the CO Time Adjustment 
icon. 

Or 

2. In the Header window with the correct 
Change Order open, click the Services 
menu and click the CO Time Adjustment 
choice. 

To view a contract item on the change order: 

1. On the Change Order Maintenance panel, 
double-click the CO Items icon. 

Or 

2. In the Header window with the correct 
Change Order open, click the Services 
menu and click the CO Items choice. 

3. In the Contract Items list box, scroll to and 
click the desired Contract Item. 

4. Click Ok.   

To access the Change Order Report: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Reports icon. 

3. On the Change Order Reports panel, 
double-click the Change Order Report 
icon. 

4. Search and select the contract. 

5. Search and select the desired Change Order 

6. Generate the report on the user’s computer 
or select to generate and/or print off-line. 

7. Click OK. 

To review or approve a Change Order: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Change Order Review 
/Approval icon. 

4. Open a Draft Change Order that has been 
forwarded for review or a Pending Change 
Order that has been sent for approval. 

5. Click the Approved or Denied radio button. 

6. Click the Save button. 

7. Enter Remarks. 
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To track the status of a change order: 

1. On the Main panel, double-click the 
Change Order icon. 

2. On the Change Order panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Tracking icon. 

4. Open a Change Order. 

5. When complete, click the Close button 

 

 



Summary Exercise for Section 4 Trns•port SiteManager® Learning Guide 
SiteManager for Management Personnel Section 4  Change Order Basics 

 

 

 125 

Summary Exercise for Section 4 
In the following exercise, you will reject a Change Order for Contract CNB022I.  

User ID: jj05756 Group: RDIR  Contract: CNB022I 

1. Navigate to the Change Order Report window. 

2. Generate the Change Order Report for Contract CNB022I, Change Order 001. 

3. What is the Change Order Type for this Change Order?      

4. Navigate to the Change Order Review/Approve window. 

5. Deny Change Order 001 for Contract CNB022I.  In the Remarks bubble, enter the reason for 
rejection as “Change Order was rejected because the number of days needs to be further 
extended.  Resubmit the change order with a completion date of 10/3/05.” 

6. What Remark is indicated for the next approver? ___________________________________ 

7. Exit SiteManager. 
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